
USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  ii 

United States Coast Guard 
 

Automatic Identification System (AIS) 

AISMiner (v4.0) User Manual 
 

June 2010 
 

 
 

 

Prepared for: 

U.S. Coast Guard  

Research and Development Center 

1 Chelsea Street 

New London, CT 06320 
 

Prepared by: 

Potomac Management Group (PMG) 

A Division of  

Advanced Technology Systems, Corp. (ATSC) 

7925 Jones Branch Drive 

McLean, VA 22102 

 

Distribution Statement A: Approved for public release; distribution is unlimited. 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  iii 

Table of Contents 

1 AISMINER OVERVIEW .................................................................................................... 1 

1.1 Document Navigation Tip............................................................................................... 1 

2 AIS OVERVIEW .................................................................................................................. 4 

2.1 How AIS Works .............................................................................................................. 4 

2.2 Modes of Operation ........................................................................................................ 5 

2.3 AIS Messages.................................................................................................................. 5 

2.3.1 Class B’CS’ Messages ................................................................................................ 8 

2.4 Reporting Rate ................................................................................................................ 8 

2.5 AIS Systems .................................................................................................................... 9 

2.5.1 AIS Base Station ......................................................................................................... 9 

2.5.2 Class A ........................................................................................................................ 9 

2.5.3 Class B ...................................................................................................................... 11 

2.5.4 Search and Rescue Aircraft ....................................................................................... 11 

2.5.5 Aids to Navigation .................................................................................................... 11 

3 INSTALLATION ................................................................................................................ 12 

3.1 Requirements ................................................................................................................ 12 

4 SUPPORT FILES ............................................................................................................... 13 

4.1 AISMiner INI File......................................................................................................... 13 

4.1.1 Settings and Values ................................................................................................... 13 

4.1.2 Example – Configure AISMiner INI file for Reading Live Data ............................. 17 

4.2 Filters INI File............................................................................................................... 20 

4.3 Base Information File ................................................................................................... 21 

4.4 Vessel List File ............................................................................................................. 22 

5 MAIN INTERFACE – MENU ........................................................................................... 24 

5.1 File ................................................................................................................................ 24 

5.1.1 Read Live Data ......................................................................................................... 25 

5.1.2 Filter Live Data ......................................................................................................... 30 

5.1.3 Open file.................................................................................................................... 31 

5.1.4 Print Display to File .................................................................................................. 34 

5.1.5 Export ........................................................................................................................ 36 

5.1.6 Exit ............................................................................................................................ 55 

5.2 View .............................................................................................................................. 55 

5.2.1 Default....................................................................................................................... 55 

5.2.2 View # (1 - 4) ............................................................................................................ 55 

5.2.3 Edit a View ............................................................................................................... 55 

5.3 Tools ............................................................................................................................. 58 

5.3.1 Edit Filters ................................................................................................................. 58 

5.3.2 Apply Selected Filters ............................................................................................... 62 

5.3.3 Edit Receiver Info View ........................................................................................... 62 

5.3.4 View Receiver Info ................................................................................................... 63 

5.4 Options .......................................................................................................................... 64 

5.4.1 Pin to Top .................................................................................................................. 64 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  iv 

5.4.2 Enable Live Mode Logging ...................................................................................... 64 

5.4.3 Medler ....................................................................................................................... 65 

5.5 Help ............................................................................................................................... 68 

5.5.1 About......................................................................................................................... 68 

6 MAIN INTERFACE - TABLE VIEW .............................................................................. 69 

6.1 Addressed Flag.............................................................................................................. 69 

6.2 Addressed Station ID 1 ................................................................................................. 69 

6.3 Addressed Station ID 2 ................................................................................................. 69 

6.4 Age of Pos Rpt .............................................................................................................. 69 

6.5 Aid to Nav Type............................................................................................................ 69 

6.6 AIS Version .................................................................................................................. 70 

6.7 Altitude (GNSS)(m) ...................................................................................................... 70 

6.8 Application ID .............................................................................................................. 70 

6.9 Beam ............................................................................................................................. 70 

6.10 Bearing .......................................................................................................................... 70 

6.11 Binary Data Flag ........................................................................................................... 70 

6.12 Bit Count ....................................................................................................................... 71 

6.13 Call Sign........................................................................................................................ 71 

6.14 Cargo Type.................................................................................................................... 71 

6.15 Channel A ..................................................................................................................... 71 

6.16 Channel A Bandwidth ................................................................................................... 71 

6.17 Channel B...................................................................................................................... 71 

6.18 Channel B Bandwidth ................................................................................................... 71 

6.19 COG .............................................................................................................................. 72 

6.20 Cumulative Range ......................................................................................................... 72 

6.21 Current System Time (GMT)........................................................................................ 72 

6.22 Current System Time (local) ......................................................................................... 72 

6.23 Current System Time (POSIX) ..................................................................................... 72 

6.24 Date Tag First Rpt (GMT) ............................................................................................ 72 

6.25 Date Tag First Rpt (local) ............................................................................................. 73 

6.26 Date Tag Last Rpt (GMT) ............................................................................................. 73 

6.27 Date Tag Last Rpt (local) .............................................................................................. 73 

6.28 Day ................................................................................................................................ 73 

6.29 Destination .................................................................................................................... 73 

6.30 Destination ID ............................................................................................................... 74 

6.31 Destination ID 1 ............................................................................................................ 74 

6.32 Destination ID 2 ............................................................................................................ 74 

6.33 Destination ID 3 ............................................................................................................ 74 

6.34 Destination ID 4 ............................................................................................................ 74 

6.35 Destination ID A ........................................................................................................... 74 

6.36 Destination Indicator ..................................................................................................... 75 

6.37 Dimension (A, B, C, and D) ......................................................................................... 75 

6.38 Draught ......................................................................................................................... 75 

6.39 Elapsed Time Since Last Pos Rpt ................................................................................. 75 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  v 

6.40 ETA ............................................................................................................................... 75 

6.41 Hour .............................................................................................................................. 76 

6.42 IMO # ............................................................................................................................ 76 

6.43 Keep Flag ...................................................................................................................... 76 

6.44 Last Report Channel ..................................................................................................... 76 

6.45 Last Report Timetag (Age) ........................................................................................... 76 

6.46 Last Report Timetag (Arrival Delta) ............................................................................. 76 

6.47 Last Rpt UTC (secs)...................................................................................................... 76 

6.48 Last VDM type ............................................................................................................. 77 

6.49 Latitude ......................................................................................................................... 77 

6.50 Latitude (degs) .............................................................................................................. 77 

6.51 Latitude 1 ...................................................................................................................... 77 

6.52 Latitude 2 ...................................................................................................................... 77 

6.53 Length ........................................................................................................................... 77 

6.54 Line # First Pos ............................................................................................................. 78 

6.55 Line # First Valid Pos ................................................................................................... 78 

6.56 Line # Max Range ......................................................................................................... 78 

6.57 Local OS Clock (UTC) ................................................................................................. 78 

6.58 Longitude ...................................................................................................................... 78 

6.59 Longitude (degs) ........................................................................................................... 78 

6.60 Longitude 1 ................................................................................................................... 79 

6.61 Longitude 2 ................................................................................................................... 79 

6.62 Minute ........................................................................................................................... 79 

6.63 Month ............................................................................................................................ 79 

6.64 Name ............................................................................................................................. 79 

6.65 Nav Solution Date (GMT) ............................................................................................ 80 

6.66 Nav Solution Time (GMT) ........................................................................................... 80 

6.67 Nav Solution Time (UTC) ............................................................................................ 80 

6.68 Nav Status ..................................................................................................................... 80 

6.69 Number of Slots ............................................................................................................ 80 

6.70 Offset 1.......................................................................................................................... 80 

6.71 Part Number .................................................................................................................. 80 

6.72 Pos Accuracy ................................................................................................................ 81 

6.73 Pos Fix Type ................................................................................................................. 81 

6.74 Pos Report Period (secs) ............................................................................................... 81 

6.75 Pos Report Rate (#/[pos rpt period/60]) ........................................................................ 81 

6.76 # Pos Rpts ..................................................................................................................... 81 

6.77 # Pos Rpts Valid............................................................................................................ 82 

6.78 Power ............................................................................................................................ 82 

6.79 Quiet Time .................................................................................................................... 82 

6.80 RAIM Flag .................................................................................................................... 82 

6.81 Range ............................................................................................................................ 82 

6.82 Range - Cumulative ...................................................................................................... 82 

6.83 Range - First .................................................................................................................. 83 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  vi 

6.84 Range - Maximum ........................................................................................................ 83 

6.85 Range - Minimum ......................................................................................................... 83 

6.86 RCVR # Blocks Lost .................................................................................................... 83 

6.87 Rcvr Cumulative Lines Lost ......................................................................................... 83 

6.88 RCVR # Lines Lost Total ............................................................................................. 84 

6.89 Rcvr ID.......................................................................................................................... 84 

6.90 Rcvr Largest Lost Block ............................................................................................... 84 

6.91 Rcvr Last Index ............................................................................................................. 84 

6.92 Rcvr Last Lost Block End Time ................................................................................... 84 

6.93 Rcvr Last Lost Block Size ............................................................................................ 85 

6.94 Rcvr Last Lost Block Start Time .................................................................................. 85 

6.95 Rcvr Pct Lost................................................................................................................. 85 

6.96 RCVR Total Expected Line Count ............................................................................... 85 

6.97 Rcvr Total Line Count .................................................................................................. 85 

6.98 Rcvr UTC Error ............................................................................................................ 86 

6.99 Received Stations .......................................................................................................... 86 

6.100 Reference Altitude .................................................................................................... 86 

6.101 Reference COG ......................................................................................................... 86 

6.102 Reference SOG ......................................................................................................... 86 

6.103 Repeat Indicator ........................................................................................................ 86 

6.104 Report Period ............................................................................................................ 86 

6.105 Report Period (secs) .................................................................................................. 87 

6.106 Report Rate ............................................................................................................... 87 

6.107 Report Rate A ........................................................................................................... 87 

6.108 Report Rate B ............................................................................................................ 87 

6.109 Reporting Interval ..................................................................................................... 87 

6.110 # Reports ................................................................................................................... 87 

6.111 # Reports A ............................................................................................................... 87 

6.112 # Reports B ............................................................................................................... 88 

6.113 # Rpts Total ............................................................................................................... 88 

6.114 Retransmit Flag ......................................................................................................... 88 

6.115 ROT........................................................................................................................... 88 

6.116 RSSI Level A ............................................................................................................ 88 

6.117 RSSI Level B ............................................................................................................ 88 

6.118 (S_M) Cumulative dBm ............................................................................................ 89 

6.119 (S_M) Signal Level in dBm ...................................................................................... 89 

6.120 (S_M) Slot Number................................................................................................... 89 

6.121 (S_M) Timestamp ..................................................................................................... 89 

6.122 (S_M) TOA UTC ...................................................................................................... 89 

6.123 (S_M) Total # dBm Reports ..................................................................................... 89 

6.124 Second ....................................................................................................................... 89 

6.125 Sequence # ................................................................................................................ 90 

6.126 Sequence #1 .............................................................................................................. 90 

6.127 Sequence #2 .............................................................................................................. 90 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  vii 

6.128 Sequence #3 .............................................................................................................. 90 

6.129 Sequence #4 .............................................................................................................. 90 

6.130 Ship Type .................................................................................................................. 90 

6.131 Slot Increment ........................................................................................................... 90 

6.132 Slot Number .............................................................................................................. 91 

6.133 Slot Offset ................................................................................................................. 91 

6.134 Slot Timeout.............................................................................................................. 91 

6.135 SOG........................................................................................................................... 91 

6.136 SOG (kt) .................................................................................................................... 91 

6.137 Station Type .............................................................................................................. 92 

6.138 Sync State.................................................................................................................. 92 

6.139 Text ........................................................................................................................... 92 

6.140 Timestamp................................................................................................................. 92 

6.141 Time Tag First Rpt (GMT) ....................................................................................... 92 

6.142 Time Tag First Rpt (local) ........................................................................................ 92 

6.143 Time Tag Last Rpt (GMT) ........................................................................................ 93 

6.144 Time Tag Last Rpt (local) ......................................................................................... 93 

6.145 Time Tag Last Rpt (UTC)......................................................................................... 93 

6.146 Transitional Zone Size .............................................................................................. 93 

6.147 True Heading ............................................................................................................ 94 

6.148 Tx Mode .................................................................................................................... 94 

6.149 Tx/Rx Mode .............................................................................................................. 94 

6.150 UTC Hour/Minute ..................................................................................................... 94 

6.151 UTC Hour/Minute (CS) ............................................................................................ 95 

6.152 Vendor ID ................................................................................................................. 95 

6.153 Vessel ID ................................................................................................................... 95 

6.154 Year ........................................................................................................................... 95 

7 RECEIVER VIEW WINDOW - TABLE VIEW ............................................................. 96 

7.1 FSR Count ..................................................................................................................... 96 

7.2 FSR Count A ................................................................................................................. 96 

7.3 FSR Count B ................................................................................................................. 96 

7.4 FSR CRC Failures A ..................................................................................................... 96 

7.5 FSR CRC Failures B ..................................................................................................... 96 

7.6 FSR High Noise A ........................................................................................................ 96 

7.7 FSR High Noise B ........................................................................................................ 97 

7.8 FSR Low Noise A ......................................................................................................... 97 

7.9 FSR Low Noise B ......................................................................................................... 97 

7.10 FSR Noise A Delta........................................................................................................ 97 

7.11 FSR Noise B Delta ........................................................................................................ 97 

7.12 FSR Noise Level A ....................................................................................................... 97 

7.13 FSR Noise Level B ....................................................................................................... 97 

7.14 FSR Report Time .......................................................................................................... 97 

7.15 FSR Report Time A ...................................................................................................... 98 

7.16 FSR Report Time B ...................................................................................................... 98 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  viii 

7.17 FSR Slots Occupied A .................................................................................................. 98 

7.18 FSR Slots Occupied B .................................................................................................. 98 

7.19 Rcvr ID.......................................................................................................................... 98 

7.20 Rcvr Last Lost Block Duration ..................................................................................... 98 

7.21 Rcvr Last Lost Block Start ............................................................................................ 98 

7.22 Rcvr Lost Line % .......................................................................................................... 99 

7.23 Rcvr Total Line Count .................................................................................................. 99 

7.24 Rcvr VDM Rpts A ........................................................................................................ 99 

7.25 Rcvr VDM Rpts B ........................................................................................................ 99 

7.26 Rcvr Lost Block Count ................................................................................................. 99 

7.27 Shine 10 Count .............................................................................................................. 99 

8 EXAMPLE DATA ANALYSIS ....................................................................................... 100 

9 AUTOMATED DATA PROCESSING ........................................................................... 107 

9.1 Example [1]: Extract as Viewed ................................................................................. 108 

9.2 Example [2]: Generate Filtered Output ....................................................................... 108 

9.3 Example [3]: Extract as Viewed – Yesterdays Data ................................................... 109 

9.4 Example [4]: Filter Live Data ..................................................................................... 110 

9.5 Example [5]: Extract as Viewed – Working Directory ............................................... 110 

APPENDIX A. LIST OF TERMS AND ABBREVIATIONS ......................................... A-1 

APPENDIX B. REFERENCES .......................................................................................... B-1 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  ix 

Table of Figures 

Figure 1.  Navigation Tip – customize quick access toolbar button. .............................................. 1 
Figure 2.  Navigation Tip – popular commands dropdown button. ................................................ 2 
Figure 3.  Navigation Tip – quick access toolbar list. .................................................................... 2 
Figure 4.  Navigation Tip – quick access toolbar. .......................................................................... 3 

Figure 5.  AIS – transmission slots. ................................................................................................ 5 
Figure 6.  AIS – position/dimension message reference point. .................................................... 10 
Figure 7.  AISMiner – missing support file error message. .......................................................... 13 
Figure 8.  AISMiner INI File – remote source settings. ............................................................... 18 
Figure 9.  AISMiner INI File – destination settings. .................................................................... 19 

Figure 10.  AISMiner INI File – user name and location name settings. ..................................... 20 
Figure 11.  AISMiner – filters INI file example. .......................................................................... 20 

Figure 12.  AISMiner – base information file example. ............................................................... 21 
Figure 13.  AISMiner – vessel names retrieved from vessel list file. ........................................... 22 
Figure 14.  AISMiner – vessel list file example. .......................................................................... 23 
Figure 15.  AISMiner – main interface. ........................................................................................ 24 

Figure 16.  Live data mode data flow. .......................................................................................... 25 
Figure 17.  AISMiner – live data mode. ....................................................................................... 26 

Figure 18.  AISMiner – live data mode contact information. ....................................................... 27 
Figure 19.  AISMiner – live data mode contact information update. ........................................... 27 
Figure 20.  AISMiner – default menu item. .................................................................................. 28 

Figure 21.  AISMiner – apply selected filters menu item. ............................................................ 28 
Figure 22.  AISMiner – enable live mode logging menu item. .................................................... 28 

Figure 23.  AISMiner – read live data menu item. ....................................................................... 29 
Figure 24.  AISMiner – live data logging. .................................................................................... 29 

Figure 25.  AISMiner – filter live data warning message. ............................................................ 30 
Figure 26.  AISMiner – filter live data menu item. ...................................................................... 30 
Figure 27.  AISMiner – saved data mode default view. ............................................................... 31 

Figure 28.  AISMiner – open file menu item. ............................................................................... 32 
Figure 29.  AISMiner – resume playback button. ......................................................................... 33 

Figure 30.  AISMiner – playback of saved log file....................................................................... 33 
Figure 31.  AISMiner – restart playback button. .......................................................................... 34 
Figure 32.  AISMiner – data file processing complete message................................................... 34 

Figure 33.  AISMiner – print display to file menu item. .............................................................. 35 
Figure 34.  AISMiner – export menu options. .............................................................................. 36 
Figure 35.  AISMiner – generate filtered output processing. ....................................................... 37 
Figure 36.  Notepad – generate filtered output file. ...................................................................... 38 
Figure 37.  AISMiner – processing complete notification message. ............................................ 38 

Figure 38.  AISMiner – view editor window. ............................................................................... 41 
Figure 39.  AISMiner – custom table view. .................................................................................. 41 
Figure 40.  Excel – extract as viewed csv output file. .................................................................. 42 
Figure 41.  Excel – extract as viewed (fresh data) csv output file. ............................................... 45 

Figure 42.  Excel – generate PRDC sentences output log file. ..................................................... 46 
Figure 43.  AIS – position/dimension message reference point. .................................................. 52 
Figure 44.  Notepad – generate PRDC sentences output log file.................................................. 53 
Figure 45.  Excel – echo and expand output csv file. ................................................................... 54 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  x 

Figure 46.  AISMiner – edit a view sub-menu items. ................................................................... 56 

Figure 47.  AISMiner – view editor window. ............................................................................... 57 

Figure 48.  AISMiner – custom table view. .................................................................................. 57 
Figure 49.  AISMiner – filter editor window. ............................................................................... 59 
Figure 50.  AISMiner – filter editor window – receivers section. ................................................ 60 
Figure 51.  AISMiner – filter editor window – speed section. ..................................................... 61 
Figure 52.  AISMiner – filtered data. ............................................................................................ 61 

Figure 53.  AISMiner – apply selected filters menu item. ............................................................ 62 
Figure 54.  AISMiner – edit receiver info view menu item. ......................................................... 62 
Figure 55.  AISMiner – receiver view editor window. ................................................................. 63 
Figure 56.  AISMiner – receiver view window. ........................................................................... 64 
Figure 57.  AISMiner – pin to top menu item............................................................................... 64 

Figure 58.  Notepad – live mode log file. ..................................................................................... 65 

Figure 59.  AISMiner – Medler menu options. ............................................................................. 65 
Figure 60.  AISMiner – insert Medler into live data menu item. .................................................. 66 

Figure 61.  AISMiner – use Medler for playback menu item. ...................................................... 67 

Figure 62.  AISMiner – set Medler playback step menu item. ..................................................... 68 
Figure 63.  AISMiner –Medler step editor window. ..................................................................... 68 
Figure 64.  AISMiner – about window. ........................................................................................ 68 

Figure 65.  AIS – reference point dimensions. ............................................................................. 75 
Figure 66.  Heading and course over ground example. ................................................................ 94 

Figure 67.  AISMiner – view editor window. ............................................................................. 101 
Figure 68.  AISMiner – filter editor window example settings. ................................................. 102 
Figure 69.  AISMiner – custom analysis results. ........................................................................ 103 

Figure 70.  Excel – sort window. ................................................................................................ 103 
Figure 71.  Excel – subtotal window – average analysis. ........................................................... 104 

Figure 72.  Excel – subtotal results. ............................................................................................ 104 
Figure 73.  Excel – receiver average analysis results. ................................................................ 104 

Figure 74.  Excel – subtotal window – count analysis. ............................................................... 105 
Figure 75.  Excel – receiver count analysis results. .................................................................... 105 

Figure 76.  Excel – receiver average and count analysis results. ................................................ 105 
Figure 77.  Excel – subtotal window – max analysis. ................................................................. 106 
Figure 78.  Excel – receiver max analysis results. ...................................................................... 106 

Figure 79.  Excel – receiver average, count, and max analysis results. ...................................... 106 
Figure 80.  Automated Data Processing – example [1] batch file. ............................................. 107 
Figure 81.  Automated Data Processing – example [2] batch file. ............................................. 111 

 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  xi 

List of Tables  

Table 1.  List of AIS messages. ...................................................................................................... 6 
Table 2.  Class A – message reporting intervals. ............................................................................ 8 
Table 3.  Non Class A – message reporting intervals. .................................................................... 8 
Table 4.  AISMiner INI file – destination IP and destination port setting values. ........................ 19 

Table 5.  Export menu item – file format options. ........................................................................ 36 
Table 6.  Extract as viewed menu item – record field population example. ................................. 40 
Table 7.  Extract as viewed (fresh data) menu item – record field population example. ............. 44 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  1 

1 AISMINER OVERVIEW 

The AISMiner application allows a user to monitor, filter, and analyze live and archived AIS (§ 

Appendix A) data.  The application is designed to accept and process AIS data formatted in either 

R&DC proprietary or NMEA v4.0 protocol.  This document describes setup and use of the 

AISMiner version 4.0 application. 

The AISMiner application was originally developed by the R&DC as an AIS analysis tool to study 

and evaluate NAIS (§ Appendix A) performance, operational condition, ship movement, and vessel 

traffic information.  Throughout the NAIS Increment 1 (I-1) deployment process (2005 – 2008), the 

application expanded, from its original design as an AIS analysis tool, to a monitoring tool used to 

check and validate I-1 site and NAIS network performance.  Following USCG acquisition of the 

NAIS I-1 network in 2008, the application again expanded to support custom analyses tailored to 

meet specific requirements of NAIS operators.  As efforts to acquire the NAIS Increment 2 (I-2) 

network advance, the application will continue to expand and change to meet the needs of USCG 

and NAIS Sustainment and Operational community.     

Note: When viewing this document in print, the actual colors of highlighted or outlined areas of an 

image may appear different than stated colors.  

1.1 Document Navigation Tip 

Microsoft Word 2007 provides an easy way to return to a previous spot in a document after clicking 

a hyperlink.  To enable this feature follow these steps:   

1. Click the Customize Quick Access Toolbar button (red outline – Figure 1), then select the 

More Commands menu item. 

 

Figure 1.  Navigation Tip – customize quick access toolbar button. 

2. Click the Popular Commands dropdown button and select All Commands (red outline – 

Figure 2). 
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Figure 2.  Navigation Tip – popular commands dropdown button. 

3. Using the Add button (blue outline – Figure 3), add the Back (red outline – Figure 3) and 

Forward command buttons to the Quick Access Toolbar list. 

 

Figure 3.  Navigation Tip – quick access toolbar list. 
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4. To save your changes to the Quick Access Toolbar (red outline – Figure 4), and exit the 

Word Options window, click the Ok button.  

 

Figure 4.  Navigation Tip – quick access toolbar. 

Note:  The Forward and Back buttons work the same as those of a web browser.  
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2 AIS OVERVIEW 

The Automatic Identification System (AIS) is a shipboard broadcast system that is capable of 

automatically providing information about a ship to other ships and coastal authorities.  It allows 

ships to easily track, identify, and exchange navigation information from one another or shore based 

units.  AIS uses Self-Organizing Time Division Multiple Access (SOTDMA) technology to provide 

the ship's identity, type, position, course, speed, navigational status and other safety-related 

information for collision avoidance, security and Vessel Traffic Services (VTS) reporting.  All AIS-

equipped stations in the vicinity continually update this information, near real-time. 

The AIS device transmits a VHF signal containing AIS message data. The message is in NMEA 

0183 format.  A land based receiver site using AISSource (§ Appendix A) software tags and 

retransmits the AIS message. The AISSource software tags each message with the receiver ID and 

the time of reception.  The modified message is then transmitted, via the Internet, to an AIS server, 

which distributes it to connected AISUser (§ Appendix A) clients. 

Note:  The time of reception is the local time of the computer that is running AISSource measured in 

seconds elapsed since midnight on January 1, 1970. 

2.1 How AIS Works 

AIS operates as a dual channel transponder in the VHF maritime band, and is capable of handling 

more than 4,500 reports per minute.  Each AIS unit receives information simultaneously on two 

separate Time Division Multiple Access (TDMA) receivers and alternates transmissions on two 

independent frequency channels using a single TDMA transmitter.  A marine electronic 

communications link enables communication between AIS and the shipboard display and sensor 

systems.  Position and timing information is obtained from a global navigation satellite system 

(GPS) receiver, but heading, course, speed over ground, and other inputs are obtained electronically 

from shipboard equipment.  

The AIS transponder normally works continuously in a self-determining mode, regardless of 

operating area.  The transmitter uses a 9.6 kb Gaussian Minimum Shift Keying (GMSK) modulation, 

a form of Frequency Modulation (FM), over 12.5 or 25 KHz channels.  Frames group the 

transmission, each frame equals one (1) minute and is divided into 2250 slots.  Each AIS unit 

determines its own transmission schedule (slot) and may use up to five consecutive slots for one (1) 

continuous transmission.  For example, a position report from one AIS station fits into one of 2250 

time slots and a Safety Related Broadcast message uses up to five slots. Figure 5 below provides an 

illustration of AIS transmission for 1 Channel. 
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Figure 5.  AIS – transmission slots. 

The International Maritime Organization (IMO) performance standard requires that the ship 

reporting capacity be no less than 2000 per minute.  AIS provides 4500 time slots per minute, 2250 

slots on each channel, and when the system is in a ship-to-ship mode it can be overloaded by 400 to 

500% through sharing of slots. While overloaded, only targets further away are subject to dropout.  

For ships closer than 8 to 10 nautical miles (NM), throughput is still close to 100%. Because AIS is a 

VHF application, the system coverage range varies with atmospheric conditions and the height of the 

antenna.  A typical value to be expected at sea is 20 nautical miles without the help of a repeater 

station. 

2.2 Modes of Operation 

AIS uses three modes of operation.  The system is usually used in the default mode, Autonomous 

and Continuous, and is only switched to/from other modes as directed by a competent authority. 

• Autonomous and continuous:  A station operating in Autonomous and Continuous mode is 

continuously receiving and automatically resolving scheduling conflicts with other stations 

by determining its own schedule for transmitting its position.  

• Assigned:  A station operating in the Assigned mode uses a transmission schedule assigned 

by a competent authority's base or repeater station. 

• Polled:  Stations operating in Polled mode automatically respond to Interrogation messages 

(message 15) from a ship or competent authority without conflicting with operations in the 

other two modes. The response is transmitted on the channel where the Interrogation message 

was received. 

2.3 AIS Messages 

AIS uses two types of messages, Functional and System Management.  Functional messages provide 

information about the ship or station.  System Management messages supply necessary information 

to maintain the system.  Some messages contain both functional and system management 

information.  All AIS messages contain a message Identifier, Repeat Indicator and have an 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  6 

associated priority.  Because of message priority and message content usefulness, all messages are 

not transmitted at the same interval.  Messages with lower priority or static information are not 

transmitted as often as high priority messages with changing information. The faster a ship’s 

information changes, the more frequently the message that contains that information is transmitted.  

Table 1 below briefly describes all 26 AIS messages. 

Table 1.  List of AIS messages. 

message 

ID 
Name Description Priority Category 

Operating 

Mode 

Mobil/ 

Base 
AS = Assigned.                                                                       F/S = Functional and System Management message. 

AU = Autonomous.                                                                 IN = Interrogation/Polled mode. 

B = transmitted by base station                                               M = transmitted by mobile station. 

F = Functional message.                                                         S = System Management message. 

 

1 Position Report Scheduled position 

Report 
1 F/S AU M 

2 Position Report Assigned Scheduled 

position Report 
1  AS M 

3 Position Report Special position report, 

response to interrogation 
1 F/S AU M 

4 Base Station Report Position, UTC, Date and 

current Slot number of 

base station 

1 F/S AS B 

5 Static and Voyage 
Related Data 

Scheduled static and 

voyage related vessel data 

report 

4 F AU, AS M 

6 Binary Addressed 
message 

Binary data for addressed 

communication 
4 F AU, AS, IN M/B 

7 Binary 

Acknowledgement 

Acknowledgement of 

received addressed binary 

data 

1 S AU, AS, IN M/B 

8 Binary broadcast 
message 

Binary data for broadcast 

communication 
4 F AU, AS, IN M/B 

9 Standard SAR 

Aircraft Position 
Report 

Position Report for 

airborne stations involved 

in Search and Rescue 

(SAR) operations 

1 F/S AU, AS M 

10 UTC/Date inquiry Request Universal Time 

Coordinated (UTC) and 

date 

3 F/S AU, AS, IN M/B 

11 UTC/Date 

Response 
Current UTC and date if 

available 
3 F/S AU, AS, IN M 

12 Addressed Safety 
Related messages 

Safety related data for 

addressed communication 
2 F AU, AS, IN M/B 

13 Safety Related 

Acknowledgement 

Acknowledgement of 

received addressed safety 

related message 

1 S AU, AS, IN M/B 

14 Safety Related 

Broadcast message 

Safety related data for 

broadcast communication 
2 F AU, AS, IN M/B 

15 Interrogation Request for a specific 

message type (can result 

in multiple responses 

from one or several 

stations) 

3 F AU, AS, IN M/B 

16 Assignment Mode 

Command 

Assignment of a specific 

report behavior by 

competent authority using 

a base station 

1 F/S AS B 
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Table 1.  List of AIS messages (Con’t). 

message 

ID 
Name Description Priority Category 

Operating 

Mode 

Mobil/ 

Base 
AS = Assigned.                                                                       F/S = Functional and System Management message. 

AU = Autonomous.                                                                 IN = Interrogation/Polled mode. 

B = transmitted by base station                                               M = transmitted by mobile station. 

F = Functional message.                                                         S = System Management message. 

 

17 DGNSS Broadcast 
Binary message 

Differential Global 

Navigation Satellite 

Systems (DGNSS) 

corrections provided by a 

base station 

2 F AS B 

18 Standard Class B 
Equipment Position 

Report 

Standard Position Report 

for Class B Shipborne 

Mobile Equipment to be 

used instead of messages 

1, 2, 3 

1 F/S AU, AS M 

19 Extended Class B 
Equipment Position 

Report 

Extended Position Report 

for Class B Shipborne 

Mobile Equipment; 

contains additional static 

information 

1 F/S AU, AS M 

20 Data Link 
Management 
message 

Reserve slots for base 

station(s) 
1 S AS B 

21 Aids-to-Navigation 
Report 

Position and Status 

Report for Aids-to-

Navigation 

1 F/S AU, AS, IN M/B 

22 Channel 
Management 

Management of channels 

and transceiver modes by 

a base station 

1 S AS B 

23 Group Assignment 

Command 

     

24 Class B ‘CS’ Static 

Data Report 

Used by Class B ‘CS’ 

shipborne Mobile 

Equipment 

    

25 Single slot binary 

message 

Short unscheduled binary 

data transmission 
4 F AU M/B 

26 Multiple slot binary 

message with 

communication 

state 

Scheduled binary data 

transmission 
4 F AU M/B 

Each message is designed to perform a unique task and has a transmission schedule that is 

determined by that task.  Even if the priority, category, operating mode, and base/mobile properties 

are the same, the transmission schedule may not be.  For example messages 1, 9, and 18 are position 

reports but have different tasks and transmitting schedules.  Message 1 (Position Report) is output 

periodically by a mobile station as determined by its dynamic information rate of change.  Message 

9 (Standard SAR Aircraft Position Report) is used as a position report for aircraft involved in Search 

and Rescue (SAR) operations and has a default-reporting interval of 10 seconds.  Message 18 

(Standard Class B Equipment Position Report) is output periodically and autonomously as is 

messages 1, 2, and 3, but is used by Class B shipborne mobile equipment and is transmitted in two 

slots once every 6 minutes.  Other messages are only output as a result of a request for additional 

information.  Message 19 (Extended Class B Equipment Position Report) is used when allocated by 
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message 18, and message 11 (UTC/Date Response) is transmitted as a result of a UTC Request 

message (message 10). 

AIS stations can request messages by using the Interrogation message (message 15) to request a 

specific message.  The type of platform to which the interrogation is directed limits the number of 

message requests.  A Class A shipborne mobile station can be interrogated for messages 3 and 5.  A 

Class B shipborne mobile station can be interrogated for messages18 and 19.  An airborne mobile 

station can be interrogated for message 9.  A mobile station mounted on an Aids-to-Navigation can 

be interrogated for message 21 and a base station can be interrogated for messages 4, 17, 20 and 22. 

2.3.1 Class B’CS’ Messages 

Class B AIS equipped vessels have a different message structure.  A new technology was developed 

called ‘Carrier-Sense TDMA (CSTDMA).  This system requires the Class B’CS’ AIS vessels to 

listen to the AIS network to determine if the network is free of activity, and, only if the network is 

free, can it transmit its information.  This allows Class B vessels to use the AIS without interfering 

with Class A operations.  Specifics of message types and their usage are in described in IEC 62287 

Ed. 1. 

2.4 Reporting Rate 

The rate at which an AIS station reports is dependent on the surrounding navigation situation. The 

different information types are applicable for different time periods.  Voyage related and static 

information is updated every 6 minutes, when data has been amended, or on request. Table 2 and 3 

below provide dynamic information update intervals for Class A and Non-Class A AIS units.  Safety 

related messages are updated as required. 

Table 2.  Class A – message reporting intervals. 

Dynamic Condition Reporting Interval 

Anchored or Moored                                               < 3 knots 3 minutes 

Anchored or Moored                                               > 3 knots 10 seconds 

Underway                                                                < 14 knots 10 seconds 

Underway and Changing Course                            < 14 knots 3 1/3 seconds 

Underway                                                            14 - 23 knots 6 seconds 

Underway and Changing Course                          14 - 23 knots 2 seconds 

Underway                                                                > 23 knots 2 seconds 

Table 3.  Non Class A – message reporting intervals. 

Condition Reporting Interval 

Class B                                                                   < 2 knots 3 minutes 

Class B                                                                   2 – 14 knots 30 seconds 

Class B                                                                  14 - 23 knots 15 seconds 

Class B                                                                   > 23 knots 5 seconds 

Search and Rescue Aircraft                                    Airborne 10 seconds 

Aids to Navigation  3 minutes 

AIS Base Station 10 seconds 
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The reporting rates in tables 2 and 3 above are changed during the synchronization process.  When a 

mobile station determines that it is the station on which synchronization is being performed, it’s 

reporting rate increases to once every 2 seconds.  A base station’s report rate increases to once every 

3 1/3 seconds when it detects it is being used for synchronization. 

2.5 AIS Systems 

The two main types of AIS systems are the AIS base station and the Class A shipborne station. The 

base stations provide the means to perform system control and maintenance.  The Class A shipborne 

station is required on commercial vessels meeting the requirements set forth by the IMO.  The other 

AIS systems are the Class B shipborne station for vessels that are not required to carry AIS, Search 

and Rescue Aircraft, and Aids to Navigation. 

2.5.1 AIS Base Station 

Base Stations act as information centers providing text messages, meteorological or hydrological 

information, navigation information, and position of other vessels.  The Base Station also provides 

system time synchronization and Differential Global Navigation Satellite System (DGNSS) 

corrections.  Message management and assignment mode command functions are performed by the 

Base Stations. 

2.5.2 Class A  

Class A shipborne mobile equipment is used on all vessels meeting the IMO AIS carriage 

requirement, described below: 

• Each self-propelled vessel of 65 feet or more in length, engaged in commercial service 

(including fishing). 

• Each towing vessel of 26 feet or more in length and more than 600 horsepower.  

• Each vessel of 100 gross tons or more carrying one or more passengers for hire.  

• Each passenger vessel certified to carry 50 or more passengers for hire.  

Each Class A station broadcasts the following information every 2 to 10 seconds while underway, 

and every 3 minutes when anchored or moored: 

• MMSI number:  unique identification.  

• Navigation status:  0 - under way using engine; 1 - at anchor; 2 - not under command; 3 - 

restricted maneuverability; 4 - constrained by draft; 5 – moored; 6 – aground; 7 - engaged in 

fishing; 8 - under way sailing. 

• Rate of turn right or left:  0 to 720 degrees per minute (input from rate-of-turn indicator if 

available).  

• Speed over ground:  1/10 knot steps from 0 to 102 knots.  

• Position accuracy:  1 = High, 0 = Low.   
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• Latitude:  to 1/10000 minute (±90 degrees, North = positive, South = negative). 

• Longitude:  to 1/10000 minute (±180 degrees, East = positive, West = negative).  

• Course over ground:  relative to true north to 1/10th degree.  

• True heading:  0 to 359 degrees derived from gyro input.  

• Time stamp:  UTC second when the report was generated (0-59). 

The Class A station also broadcasts the following static information every 6 minutes: 

• IMO number:  unique identification (1 – 999999999; 0 = not available = default).  

• Call sign:  international call sign assigned.  

• Name:  name of ship. 

• Type of ship and cargo:  0 = not available. 

• Dimensions/reference for position:  reference point for reported position and dimension of 

ship in meters (Figure 6).  

Distance is in meters 

A & B = 0 – 511m 

C & D = 0 – 63m, 63 if > 63m 

 

Figure 6.  AIS – position/dimension message reference point. 

The point in the center represents the location of the position-fixing device. 

• Type of position fixing device:  0 - Undefined (default); 1 – GPS; 2 – GLONASS; 3 - 

Combined GPS/GLONASS; 4 - Loran-C’; 5 – Chayka; 6 - Integrated Navigation System; 7 - 

surveyed. 

• Estimated time of arrival:  estimated Time of Arrival in UTC (MMDDHHMM).  

• Draft of ship:  in 1/10 meter. 

• Destination:  20 characters are provided (at master's discretion). 
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2.5.3 Class B  

Class B equipment provides AIS functionality for vessels that do not align with IMO Class A AIS 

carriage requirements.  The International Electro-technical Commission (IEC) is developing 

standards for Class B equipment development.  The Class B position report message (message 18) is 

similar to the position report message for Class A vessels.  The major difference is that the Class B 

position report does not contain navigational status or rate of turn. 

2.5.4 Search and Rescue Aircraft  

The AIS equipment used for search and rescue aircraft is similar to the AIS shipborne equipment.  It 

is used to provide position reports for aircraft involved in SAR operations. SAR aircraft equipment is 

designed to improve SAR operations and uses message 9 (Standard SAR Aircraft Position Report) 

when involved in SAR operations.  The reporting rate for this message is once every 10 seconds. 

2.5.5 Aids to Navigation  

Shore-based stations providing the locations of Aids to Navigation (AtoN) provide a more secure 

navigational picture for approaching vessels.  AIS also provide an enhanced method of real time 

monitoring and control of the ATN equipment.  AIS use message 21 (Aids-to-Navigation Report) to 

supply type, name, position, dimensions, and Off-Position Indicator of the ATN. 
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3 INSTALLATION 

To install AISMiner, follow these steps: 

1. Create a directory on your network or hard drive to hold the application and support files. 

2. Unzip the installation file to this directory.  

3. From the installation directory, open the Flexgrid folder. 

4. From the Flexgrid folder, copy the 'MSFLXGRD.OCX' file to your system directory:  
 

5.  

• For Win95 or 98 this is C:\windows\system. 

• For Win2k or NT this is C:\WINNT\system32. 

• For XP or Vista this is C:\windows\system32. 

Note:  Depending on your system configuration, you may require administrative 

account privileges to complete steps 4 through 7. 

6. Open the start menu and click 'Run'.  In Vista this command is not visible by default.  To 

access the Run window in Vista, follow these steps: 
 

• Right click on Vista Orb Start button.  

• Select “Properties” on the context menu.  

• Select the “Start Menu” tab in the window shown.  

• Click the “Customize” button that is enabled.   

• From the list provided, scroll to the “Run Command” and click the checkbox next 

to it.  For the Classic Start menu this will read “Display Run.” 

• Click the OK button.  

7. In the Run dialog box, copy or type the following command: 
 

• Windows 95 or 98:  “regsvr32 \windows\system\Msflxgrd.ocx.” 

• Windows NT or 2000:  “regsvr32 \WINNT\system32\Msflxgrd.ocx.” 

• Windows XP or Vista: “regsvr32 \windows\system32\Msflxgrd.ocx.” 
 

8. Click the Ok button to complete the MSFlexGrid ActiveX control registration process. 

9. To place an application shortcut icon on your desktop, from the installation directory 

right click the AISMiner.exe file.  In the pop-up context menu, select Send To then select 

the Desktop (create shortcut) menu item. 

10. Follow steps outlined in section 4 below to configure AISMiner initialization files for 

application runtime.    

3.1 Requirements  

AISMiner is compatible with Windows 95/98/NT/2000/XP and Vista.  The application’s main 

interface uses the MSFlexGrid ActiveX control to display processed message data.  The control must 

be registered on the hosting machine for data to display.  To accept and read live AIS data, an 

internet connection is required.  

 

 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  13 

4 SUPPORT FILES 

During runtime AISMiner uses four support files: two initialization files (‘AISMiner.ini’ and 

‘Filters.ini’); and, two information files (‘BaseInfo.txt’ and ‘VesselList.txt’).  If, at application start-

up, the AISMiner.ini support file is missing, AISMiner displays an error message (Figure 7) 

informing the user that the file will automatically be created.  When the user clicks the OK button 

AISMiner shuts down, creates the missing file, and then restarts.  If, at application startup, one of the 

remaining support files is missing AISMiner creates the file during runtime, when an application 

feature utilizing the file is accessed, or during application shutdown. 

 

Figure 7.  AISMiner – missing support file error message. 

4.1 AISMiner INI File  

4.1.1 Settings and Values 

Following is a list of AISMiner INI file settings with a description of each setting and its’ default 

value. 

4.1.1.1 Allow BaseInfo Update 

Default Value: True 

If set to True, AISMiner overwrites the BaseInfo.txt file (§ 4.3), during application shutdown, with 

receiver identification information read from the file during application startup and all new receiver 

identification information processed during runtime.   

If set to False, AISMiner does not overwrite the BaseInfo.txt file during application shutdown.  Note 

that a value of False should be used when running multiple AISMiner applications concurrently and 

more than one application references the same BaseInfo.txt file.  This is because of the way that 

AISMiner works with the BaseInfo.txt file.  At application startup, it reads and stores in memory all 

existing receiver information from the file.  During runtime it compares processed receiver 

identifications against its internal list and adds new receivers to this list.  At application shutdown, it 

deletes the contents of the BaseInfo.txt file and overwrites the file with its internal list (sorted 

numerically).  If more than one AISMiner application references the same BaseInfo.txt file during 

runtime, then the application that shuts down last will overwrite any new receiver identification 

information from other instances of AISMiner.      
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4.1.1.2 Auto Output Directory 

Default Value: C:\AISMinerAutoOut 

Important: The Auto Output Directory setting is only used by AISMiner when the application is 

started using a command line with an operational mode setting of two (2).  Also, AISMiner will 

attempt to create any missing subdirectories specified in the Auto Output Directory path.   

The Auto Output Directory setting is used to set a log file output directory path following data 

processing.  For example, if AISMiner opens log file 20100505.log for input, then the output files 

(20100505.csv and 20100505_RcvrStats.csv) will be placed in the directory listed in this setting 

(AISMinerAutoOut).  If left blank, the output files are lost [from memory] following application 

shutdown. 

Note:  The Auto Output Directory setting is used in conjunction with the Auto Source Directory 

setting. 

4.1.1.3 Auto Source Directory 

Default Value: C:\Logs 

Important: The Auto Source Directory setting is only used by AISMiner when the application is 

started using a command line with an operational mode setting of two (2).   

The Auto Source Directory setting is used to set a log file input directory path for data processing.  

AISMiner searches the directory specified in this setting for log files named using the preceding 

days date (e.g., 20100505.log).  The application first searches the directory, specified in this setting, 

for subdirectories following the naming structure year (e.g., 2010), then month (e.g., 05), then 

filename (e.g., 20100505.log).  If the search fails, AISMiner searches by month then filename.  For 

example, “C:\Logs\2010\05\20100505.log” directory path is searched first.  If the year folder is not 

found, AISMiner performs a second search starting with the month folder 

“C:\Logs\05\20100505.log”.   

Note:  The Auto Source Directory setting is used in conjunction with the Auto Output Directory 

setting. 

4.1.1.4 BaseInfo Directory 

Default Value:  [blank] 

Sets the directory path to the BaseInfo.txt file (§ 4.3) used by AISMiner at application startup.  If left 

blank, AISMiner will look for and use the BaseInfo.txt file in the application working directory.   

Note: Do not include trailing slashes in the directory path. 

4.1.1.5 Destination IP 

Default Value: 127.0.0.1 

Sets the target address of a processed data output stream.  The Destination IP setting is used in 

conjunction with the Destination Port setting. 
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For example, to send the processed data output stream to a FinCen server, the setting would read 

“nais.uscg.mil.fincen”.  The port on the FinCen server where the data is sent is defined in the 

Destination Port setting.  If the Destination IP setting is set to 0 (zero), AISMiner will host 

connections (i.e., other applications can create a connection to its host machine).   

4.1.1.6 Destination Port 

Default Value: 0 

Sets the destination port of a processed data output stream.  The Destination Port setting is used in 

conjunction with the Destination IP setting. 

For example, to send a processed data output stream to a FinCen server, the Destination IP setting 

would read “nais.uscg.mil.fincen” and the Destination Port value would be a port number on that 

server (e.g., 1234).   If the Destination IP setting is set to zero (0), then the Destination Port value 

serves as the port number on the local machine held open for connecting applications.  A Destination 

Port value of 0 (zero) suppresses this function.   

Note:  For a complete list of setting values, and associated application response, see Table 4 below.  

4.1.1.7 Last View 

Default Value: 0 

This setting is used by AISMiner during application shutdown to store the active table view (§ 5.2).  

This setting should not be edited directly by a user. 

4.1.1.8 Location Name 

Default Value: Uninitialized 

Sets an application location name; used by AISMiner when connecting to remote servers (e.g., RDC 

- New London). 

Note:  Do not use special symbols (i.e., %^&*) or quotation marks when creating an application 

location name.   

4.1.1.9 Log data in Live Mode 

Default Value: False 

If set to True, AISMiner records all data received to a log file when operating in live data mode  (§ 

5.1.1).  The location of the log file is specified using the setting LogDir.   

If set to False, data is not recorded, only processed. 

4.1.1.10 LogDir 

Default Value: C:\AISMinerLogs 

Sets the directory path where log files are saved when operating in live data mode (§ 5.1.1).  If left 

blank, log files are not generated; regardless if the setting Log data in live mode is set to True. 
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4.1.1.11 Rcvr View 

Default Value: 5701 

This setting is used by AISMiner to store configuration values set using the Receiver View Editor 

window (§ 5.3.3).  This setting should not be edited directly by a user. 

4.1.1.12 Reference Receiver ID 

Default Value: rLoggerTime 

Timestamps generated at the same time by different NAIS equipment often do not match.  During 

data processing, AISMiner compares this settings value against the (equipment) “source ID” field in 

an AIS message.  If the values match, then the message’s timestamp field value is used to populate 

the Reference Time field in the AISMiner table view.     

For example, if the message contains “/s:rLoggerTime,c:123456789/” and the Reference receiver ID 

value is “rLoggerTime”, then the Reference Time field will contain the timestamp value 

“123456789”.  The timestamp “123456789” remains valid in the Reference Time field until updated 

by another message with the specified “source ID”.  Timestamp values from processed messages 

with other source ID values are not posted to the Reference Time field.   

Note: NAIS equipment timestamps are incremented in one second intervals.   

4.1.1.13 Remote Source IP 

Default Value: ds2.rdc.uscg.gov 

The IP address or URL of remote host machine for establishing a live AIS data feed connection. 

4.1.1.14 Remote Source port 

Default Value: 31419 

The port number on remote host machine for establishing a live AIS data feed connection. 

4.1.1.15 Replace Spaces 

Default Value: True 

If set to True, AISMiner will replace all spaces in the message fields call sign, vessel name, and 

destination with an underscore character. 

If set to False, AISMiner does not perform the replace function. 

4.1.1.16 Show Extra Label Info 

Default Value: False 

If set to True, a fully qualified application working directory path is shown in the application’s main 

window title bar.   

If set to False, the application working directory name is shown in the application’s main window 

title bar. 
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4.1.1.17 Start in Live Mode 

Default Value: False 

If set to True, AISMiner starts in live data mode (§ 5.1.1). 

4.1.1.18 User Name 

Default Value: Uninitialized 

Sets a user login name; used by AISMiner when connecting to remote servers (e.g., John Doe). 

Note:  Do not use special symbols (i.e., %^&*) or quotation marks when creating a user login name.   

4.1.1.19 Utilize Internal Receiver 

Default Value: False 

If set to True, AISMiner uses internal receiver and timetag information when processing VDX 

messages that do not contain this information. 

4.1.1.20 View 1 

Default Value: 0 

This setting is used by AISMiner during application shutdown to store user configuration values for 

the View #1 menu item.  This setting should not be edited directly by a user. 

4.1.1.21 View 2 

Default Value: 0 

This setting is used by AISMiner during application shutdown to store user configuration values for 

the View #2 menu item.  This setting should not be edited directly by a user. 

4.1.1.22 View 3 

Default Value: 0 

This setting is used by AISMiner during application shutdown to store user configuration values for 

the View #3 menu item.  This setting should not be edited directly by a user. 

4.1.1.23 View 4 

Default Value: 0 

This setting is used by AISMiner during application shutdown to store user configuration values for 

the View #4 menu item.  This setting should not be edited directly by a user. 

4.1.2 Example – Configure AISMiner INI file for Reading Live Data 

To configure the AISMiner INI file for reading live AIS data, follow these steps:   

1. From the AISMiner application directory, open the “AISMiner.ini” file using a text editor 

such as Notepad. 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  18 

2. Set the Remote Source IP and Remote Source Port settings (red highlight - Figure 8) to 

the IP address and port number of the computer sending AIS data.  This information is 

available from the system administrator supplying the live data feed. 

 

Figure 8.  AISMiner INI File – remote source settings. 

Note:  The Remote Source IP value can be in either Internet Protocol version 4 (IPv4) or 

Universal Resource Locator (URL) format.  IPv4 addresses are usually written in dot-

decimal notation.  Below are examples of IP addresses in IPv4 and URL formats:  

• IPv4 -  192.168.20.18. 

• URL -  http://www.navcen.uscg.gov/enav/ais/default.htm. 

3. Set the Destination IP and Destination Port settings (red highlight - Figure 9) to the IP 

and port number of the target machine of the output data stream.  Note, the default 

Destination IP address value of 127.0.0.1 and the default Destination Port value of 0 sets 

the local machine (application host) as the target machine. 

http://www.navcen.uscg.gov/enav/ais/default.htm
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Figure 9.  AISMiner INI File – destination settings. 

Note:  The Destination IP and Destination Port setting values control how AISMiner 

processes expanded position information from messages 1, 2, 3, and 5. Table 4 below lists 

acceptable values for these settings, and how they are used by AISMiner. 

Table 4.  AISMiner INI file – destination IP and destination port setting values.  

Destination IP Destination Port How Setting Values are Applied 
n/a  Value of zero (0) No attempt is made to connect to a remote host.  No 

connections to AISMiner are permitted. 

Non-zero value  Non-zero value AISMiner attempts to connect to the IP address 

specified in the Destination IP setting.  The value of 

the Destination Port setting is the local port that 

AISMiner uses to export the data.  No connections 

to AISMiner are permitted. 

Value of zero (0) Non-zero value AISMiner does not attempt to connect to a remote 

host.  AISMiner listens on the port specified in the 

Destination Port setting. 

4. Set the LogDir setting to the location (path) where AISMiner log files will be saved.  If 

the directory does not exist, AISMiner creates the folder and adds a new log file for the 

current days live data. 

5. Set the Log data in live mode setting to True to log data while in live mode. 

6. Set the User Name and Location Name settings to values applicable to your organization.  

AISMiner uses this information to generate an identifier for server login (red outline - 

Figure 10). 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  20 

 

Figure 10.  AISMiner INI File – user name and location name settings. 

4.2 Filters INI File  

The Filters INI file (Filters.ini) stores values set using the Filter Editor window (§ 5.3.1).  At 

application start-up, AISMiner uses the file to restore values set during the previous runtime session.  

This file is not intended to be edited directly by a user. 

 

Figure 11.  AISMiner – filters INI file example. 
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4.3 Base Information File  

The Base Information file “BaseInfo.txt” contains information about known land based receiver 

stations.  During application shutdown, AISMiner creates the file if it doesn’t exist or appends new 

station information, collected during data processing, to the end of the file if it does exist.  If 

AISMiner does not receive base information for a station in a processed data sentence, the distance 

and bearing fields in the output data sentence are left blank.  Each line in the Base Information text 

file represents a station, and contains the following five fields.   

Note:  In figure 12 below, the first three lines show fully identified stations, while the last two lines 

show default information added by AISMiner when station information is not available. 

 

Figure 12.  AISMiner – base information file example.  

• Field 1:  Receiver identification number.  Each receiver is issued a unique identification 

number.  If AISMiner processes a message from an unknown receiver, it adds the 

identification number to the Base Information file and enters default information for the 

remaining fields (lines 4 and 5 in Figure 12 above). 

• Field 2:  Name of receiver station.  This field must exist, but does not have to contain a 

value.  AISMiner version 4.0 does not use the value in this field, but needs the field 

placement to maintain correct field sequence. 

• Field 3:  Latitude of receiving station.  The latitude is shown in decimal degrees between 90 

and -90.  Positive numbers indicate northerly latitudes and negative numbers indicate 

southerly latitudes.  AISMiner disregards this field if the value is greater than 90. Distance 

and bearing sentence field values are not calculated when the latitude is outside the expected 

values. 

• Field 4:  Longitude of receiving station.  The longitude is shown in decimal degrees between 

180 and -180.  Positive numbers (0 to180) indicate easterly longitudes and negative numbers 

(0 to -180) indicate westerly longitudes.  AISMiner disregards this field if the value is greater 

than 180.  Distance and bearing sentence field values are not calculated when the latitude is 

outside the expected values. 

• Field 5:  Optional comment field. 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  22 

4.4 Vessel List File 

The Vessel List file (VesselList.txt) contains information about known vessels.  AISMiner uses the 

information in this file to cross-reference the name of a vessel with the vessel ID (i.e., MMSI 

number) for each processed message that does not contain a vessel name.  Every AIS message 

contains a vessels MMSI number, but only messages 5 and 19 contain the vessel name field.  If a 

vessel name is retrieved from the Vessel List file, the name is shown in the table view followed by 

three asterisk symbols (red outline - Figure 13).    

 

Figure 13.  AISMiner – vessel names retrieved from vessel list file. 

The first time AISMiner is started it creates the Vessel List file and saves it to the application 

directory.  Each time a new vessel ID, not in the master list, is processed the vessel ID and 

associated vessel name are added to the list.  If a vessel name is not available from the processed 

message, the vessel ID is used as the vessel name when added to the list.   

Each subsequent time AISMiner is run, at startup it populates the table view with all the vessel 

names from the Vessel List “lookup” file followed by three asterisk symbols.  As new vessel ID’s 

are read from processed message data, they are added to the lookup file list and table view.  If a 

message with the vessel name (message 5 or 19) for a known vessel is received and processed, the 

three asterisk symbols are removed from the vessel name in the table view for the remainder of that 

application session. 

At application shutdown, all vessel names and vessel ID’s processed during that session, not already 

in the Vessel List file, are added to the list (Figure 14).  If, at application shutdown, the Vessel List 

file does not exist, or has been moved from its application startup location, AISMiner creates the file 

using vessel names and vessel ID’s processed during that session.   
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Figure 14.  AISMiner – vessel list file example. 
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5 MAIN INTERFACE – MENU 

Depending on choices made during application installation (§ 3), you can start AISMiner by double 

clicking the desktop shortcut icon or navigating to the application directory and double click the 

AISMiner.exe file.   

At start-up, the application’s main interface is shown (Figure 15).   

 

Figure 15.  AISMiner – main interface. 

The following subsections provide a description of application functions and features and are 

organized based on the menu structure of the main interface. 

5.1 File 

Menu Items:   

• Read live data. 

• Filter live data. 

• Open file. 

• Print display to file. 

• Export. 

o Generate Filtered Output 

o Extract as Viewed 

o Extract as Viewed (fresh data) 

o Generate PRDC sentences 

o Convert to Sim format 

o Echo and Expand 

• Exit. 
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5.1.1 Read Live Data 

The Read Live Data menu item, in conjunction with configuration settings in the AISMiner INI file 

(§ 4.1), is used to establish a connection to and begin processing of a live AIS data stream.  

Processing live AIS data is referred to as live data mode. 

Figure 16 below illustrates data flow to AISMiner in live data mode, and output to users following 

data processing.  In the illustration, AIS message data is being transmitted by search and rescue 

(SAR) aircraft, Class A and Class B vessels. When an aircraft or vessel is within VHF range of a 

receiver site the transmitted messages are received by the site’s antennas and processed by the site 

controller computer.  During processing, the site controller computer runs a separate application, 

named AISSource, which appends the receiver ID and time stamp fields and values to each message.  

If the receiver (antenna) provides signal strength data, this field and value is also appended to each 

message. AISSource then sends the message data to AISMiner via the internet.  AISMiner processes 

the data based on user defined settings.  The user can then output the data using one of five Export 

menu options (§ 5.1.5).   

 

Figure 16.  Live data mode data flow. 
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Figure 17 below shows an example of AISMiner in live data mode.  Note that while in live data 

mode the text “Reading Live Data” (yellow outline – Figure 17) is displayed in the windows titlebar.  

Also, shown in the upper left area of the main interface are the Disk Write and Contact count 

indicators (blue outline – Figure 17).  The Disk Write indicator blinks red when live data is being 

saved to a log file.  The Contact count indicator changes from black to red text and increments by 

one for each new contact received.  

 

Figure 17.  AISMiner – live data mode. 

During live data mode, AISMiner uses a table view to display processed message data.  Each row of 

the table view represents the pairing of a single receiver with a single vessel (contact) using the Rcvr 

ID and Vessel ID message fields (red outline – Figure 17 above).  As newer data (receiver/vessel 

message data with a more recent timestamp) are processed, the Name, Vessel ID, and Rcvr ID fields 

in the table view remain constant and the remaining row fields are updated based on values from 

newer message data.   
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 The blue highlighted area in figure 18 below show an example of a single vessel broadcast which 

was received by three different receivers at the same time.  This illustrates the pairing of a single 

receiver with a single vessel for each row of the table view.   

 

Figure 18.  AISMiner – live data mode contact information. 

In figure 19 below, the field values in each table row, for each Rcvr ID/Vessel ID pairing, are 

updated as data with a newer timestamp is processed.  This shows that the relationship between a 

single receiver and a single vessel remains constant in the table view during data updates. 

 

 

Figure 19.  AISMiner – live data mode contact information update. 

5.1.1.1 Example - Read Live Data 

AISMiner can be used as a data log tool or as an analysis tool.  Log files can be viewed using 

AISMiner or TransView1.  Analysis (csv) files can be analyzed using Microsoft Excel.  The 

following example demonstrates use of AISMiner as a data log tool.   

Note:  For an example of using AISMiner as an analysis tool, see section 8. 

 
1 U.S. Government developed and owned application used to display AIS track data. 
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1. Start AISMiner. 

2. From the View menu item select Default (Figure 20).    

 

Figure 20.  AISMiner – default menu item. 

3. From the Tools menu item verify that Apply Selected Filters is not checked (Figure 21).  

 

Figure 21.  AISMiner – apply selected filters menu item. 

4. From the Options menu item verify that Enable Live Mode Logging is checked (Figure 22).   

 

Figure 22.  AISMiner – enable live mode logging menu item. 

5. From the File menu item select Read Live Data (Figure 23).   
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Figure 23.  AISMiner – read live data menu item. 

Within a few seconds AISMiner starts processing the live data steam.  During processing the 

Disk Write indicator flashes red and the Contact count indicator increments by one for each 

new contact (vessel) processed by AISMiner (Figure 24). 

 

Figure 24.  AISMiner – live data logging. 

Note:  If AISMiner encounters a problem with the data steam connection, an error message is 

shown.  Dismissing the error message causes AISMiner to close.  To fix the problem, check the 

internet connection and Remote source IP setting (§ 4.1.1.13) in the AISMiner INI file. 
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When AISMiner is running in live data mode, a new log file is created at midnight local time each 

new day, and a new month folder is created on the first day of each month.  The new log file and 

folder are created in the directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10). 

5.1.2 Filter Live Data 

The Filter Live Data menu item, like the Read Live Data menu item (§ 5.1.1), is used to establish a 

connection to and begin processing of a live AIS data stream.  The difference between these two 

features is that Filter Live Data feature first checks to see that data filters have been set; based on 

settings defined in the Filter Editor window (§ 5.3.1 and § 5.3.2).  To configure AISMiner to read 

live data, see section 4.1.2.     

5.1.2.1 Example – Filter Live Data 

1. Start AISMiner. 

2. From the View menu item select Default.    

3. From the Tools menu item verify that Apply Selected Filters is checked.   

Note: Failure to perform this step causes a warning message to display at step 5 (Figure 25). 

 

Figure 25.  AISMiner – filter live data warning message. 

4. From the Options menu item verify that Enable Live Mode Logging is checked.   

5. From the File menu item select Filter Live Data (Figure 26).   

 

Figure 26.  AISMiner – filter live data menu item. 

Within a few seconds AISMiner starts processing the live data steam.  During processing the Disk 

Write indicator flashes red and the Contact count indicator increments by one for each new contact 

(vessel) processed by AISMiner. 
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Note:  If AISMiner encounters a problem with the data stream connection, an error message is 

shown.  Dismissing the error message causes AISMiner to close.  To fix the problem, check the 

internet connection and Remote source IP setting (§ 4.1.1.13) in the AISMiner INI file. 

When AISMiner is left running in live data mode, a new log file is created at midnight local time 

each new day, and a new month folder is created on the first day of each month.  The new log file 

and folder are created in the directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).   

5.1.3 Open file 

The Open File menu item is used to open a log file for processing.  Processing data in this manner is 

referred to as saved data mode.  A log file created by AISMiner, or another application such as 

TransView, can be opened in saved data mode.  Figure 27 below shows AISMiner default view in 

saved data mode.   

 

Figure 27.  AISMiner – saved data mode default view. 

Several main interface changes occur when AISMiner is in saved data mode.  The window title 

includes the words “Processing file” (red outline – Figure 27 above) along with the name of the log 

file.  In addition, a progress bar and several controls for working with a static dataset are added to 

the main interface (blue outline – Figure 27 above).    

During file processing, the Stop and Resume buttons act as toggle buttons.  The Stop button changes 

between Stop and Restart.  The Stop button is used to stop processing of a file at the current line 

number.  Data that was processed before the Stop button was clicked is displayed in the table view, 

but no further processing is performed.  The Restart button resets the interface to an initial start state 

and clears the table view of processed data.   

The Resume button toggles between Resume and Pause.  Resume and Pause are used to stop and 

restart processing from the current line number.   

The Quit playback button exits saved data mode and removes playback controls from the main 

interface. 
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5.1.3.1 Example – Read Saved Data 

The following example demonstrates AISMiner working in saved data mode.  

Note:  If you do not have a log file to work with, follow steps outlined in § 5.1.1.1 to create and save 

a log file on your computer.    

1. Start AISMiner. 

2. From the View menu item select Default (Figure 20 above).    

3. From the Tools menu item verify that Apply Selected Filters is checked (Figure 21 above).  

Note this step is optional. 

4. From the File menu item select Open File (Figure 28).   

 

Figure 28.  AISMiner – open file menu item. 

5. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).   

6. Click the Resume button to begin playback of the saved log file (blue outline - Figure 29).  

Note that the Contact count indicator increments by one for each new contact (vessel) 

processed (green outline – Figure 30), and the Resume button changes to Pause (blue outline 

– Figure 30).  The Lines read from file indicator increments by one for each log file message 

sentence processed (orange outline – Figure 30), the Current Msg Count indicator increments 

by one for each log file message group processed (purple outline – Figure 30), and the 

progress bar updates during the playback process (red outline – Figure 30). 
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Figure 29.  AISMiner – resume playback button. 

 

Figure 30.  AISMiner – playback of saved log file. 

Note:  The table view display may not update while AISMiner is processing a log file.  If the 

Contact count indicator is updating, AISMiner is processing the log file. 

7. Click the Pause button to pause log file processing.  Note that the Pause button changes to 

Resume and file processing stops at the Lines read from file number. 

8. Click the Resume button to restart file processing at the Lines read from file number. 

9. Click the Stop button to stop log file processing.  Note that the Stop button changes to Restart 

(blue outline – Figure 31). 
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Figure 31.  AISMiner – restart playback button. 

10. Click the Restart button to reset AISMiner to a beginning state (blue outline - Figure 31 

above). 

11. Click the Quit playback button (red outline - Figure 31 above).  The playback controls are 

removed from the main interface.   

Note:  After clicking the Quit playback button the table view may update to show a subset of 

processed messages.  Data shown is a result of the way AISMiner processes saved log files.  

It reads and processes a log file in sections.  When the Restart button was last clicked, 

AISMiner automatically read and processed a section of the log file, starting at position zero, 

in the event that the Resume button was next clicked.  If the Quit playback button is instead 

clicked, the table view automatically updates to show pre-processed messages in memory.    

12. When AISMiner completes processing the log file a message is shown notifying the user 

(Figure 32).   

 

Figure 32.  AISMiner – data file processing complete message. 

5.1.4 Print Display to File 

The Print Display to File menu item is used to save processed data to a local or network directory.  

It works in both live and saved data mode.  The data is saved as an Excel ‘.csv’ file.  Only data 

shown in the table view are saved (i.e., data filtered based on settings in the Filter Editor window, 

and fields shown based on settings in the View Editor window).  The csv file created contains all 

message data available from the table view, not just data shown on the current page of the table 

view.  Note that this does not include all processed [vessel contact] message data, only the most 

recently processed data viewable in the table view.  The output file row count equals the Contact 

count value when the feature is used.  To access this feature, from the File menu item select Print 

Display to File. 
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5.1.4.1 Example – Print Display to File 

The following example demonstrates use of the Print Display to File feature. 

1. Start AISMiner. 

2. From the View menu item, select View #1.  

3. From the Tools menu item verify that Apply Selected Filters is checked.   

4. From the File menu item select Open File.   

5. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).      

6. To populate the table view with data, click the Resume playback button followed by the 

Pause playback button (Figure 29 and 30 above). 

7. From the File menu item, select Print Display to File (Figure 33). 

 

Figure 33.  AISMiner – print display to file menu item. 

8. In the Save File window, enter the file name “PrintDisplayToFileTest1.csv” and click the 

Save button. 

9. Using Microsoft Excel, navigate to and open the “PrintToFileTest1.csv” file.  Note, 

depending on your version of Excel, you may need to change the open file selection to “All 

Files” to view files with a csv extension. 

10. Scroll through the contact records and verify that the fields and data shown are the same as in 

(View #1) table view.  Note that the csv file record count equals the AISMiner Contact count 

(plus one for the header row). 
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5.1.5 Export 

The Export menu item provides six menu options for working with saved log files (Figure 34).   

 

Figure 34.  AISMiner – export menu options. 

Table 5 below lists the output file formats for each of the Export menu options. 

Table 5.  Export menu item – file format options. 

5.1.5.1 Generate Filtered Output 

The Generate Filtered Output menu item creates a filtered version of a saved log file based on user 

defined settings.   

Note:  See section 5.3.1  for information on filtering data using the Filter Editor window. 

5.1.5.1.1 Example – Generate Filtered Output 

The following example demonstrates the Generate Filtered Output feature.  

1. Start AISMiner. 

2. From the View menu item, select Default. 

3. To open the Filter Editor window, from the Tools menu item select Edit Filters.   

Option Name 
Output 

File Type 

Filter Settings 

Apply 

Output 

Compatible With 

Generate Filtered Output  .log Yes AIS Miner 

Extract as Viewed .csv Yes Excel 

Extract as Viewed (fresh data) .csv Yes Excel 

Generate PRDC sentences .log Yes AIS Miner 

Convert to SIM Format .amo Yes UAIS Simulation 

Echo and Expand .csv Yes Excel 
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4. Using the Filter Editor radio buttons, disable all filters except the Receivers filter.  For 

demonstration purposes, select only two receivers from the Receivers section.  In this 

example receivers r003669957 and r003669959 are used.  Click the Ok button to save the 

changes and close the window.   

5. From the Tools menu item verify that Apply Selected Filters is checked.   

6. From the File menu item select Export then Generate Filtered Output.   

7. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner.ini file setting LogDir (§ 4.1.1.10).       

8. In the Save As window, enter the file name “GenerateFilteredOutputTest1.log” and click the 

Save button. By default the file is saved to the application directory. 

9. Click the Resume playback button to begin processing of the filtered output file.  Note that 

the Disk Write indicator blinks red (red outline – Figure 35), the Contact count, Lines read 

from file, and Current Msg Count indicators begin to increment (blue outline – Figure 35), 

and the table view updates with contact information.   

 

Figure 35.  AISMiner – generate filtered output processing. 

10. Allow AISMiner a few seconds to process part of the log file then click the Stop playback 

button.     

11. Using Notepad, navigate to the application directory and open the filtered log file 

“GenerateFilteredOutputTest1.log”.  Figure 36 below shows an example of a filtered log file.  

Note that only message data from the two receivers selected in step 4 above was saved to the 

file (red outline – Figure 36). 
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Figure 36.  Notepad – generate filtered output file. 

12. Click the Restart then Resume playback buttons to restart the Generate Filtered Output 

process.  Allow the process to run until completion. Once complete, a notification message is 

shown (Figure 37). 

 

 

Figure 37.  AISMiner – processing complete notification message. 

5.1.5.2 Extract as Viewed 

The Extract as Viewed menu item is used to save processed data to a local or network directory.  The 

data is saved as an Excel ‘csv’ file.  The feature only works in saved data mode.  Like the Print 

Display to File feature (§ 5.1.4), only filtered data (based on settings in the Filter Editor window), 

and fields shown in the table view (based on settings in the View Editor window), are saved to the 

csv output file.  Unlike the Print Display to File feature, the csv file created is based on all processed 

message data, not just the most recently processed message data shown in the table view.     

Table 6 below shows an example of the record-field data population, in the csv output file, for a 

single contact/receiver pairing using the Extract as Viewed feature.  In the example, the table 

columns Last VDM type, VDM01 Latitude (degs), VDM02 Latitude (degs), and VDM04 Latitude 
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(degs) represent fields shown in the AISMiner table view.  In the example, a contact transmitted ten 

messages to a receiver; which were processed by AISMiner.  The message type for each transmitted 

message is shown in the column Last VDM type.   

The message type for record number one (yellow shading – Table 6) is VDM01.  Using the Extract 

as Viewed feature, the field VDM01 Latitude (degs), in record number one, would be populated with 

data from the message, but not the fields VDM02 Latitude (degs), and VDM04 Latitude (degs) as a 

VDM01 message does not contain data for these two fields.   

The message type for record number two (green shading – Table 6) is VDM02.  Using the Extract as 

Viewed feature, the field VDM01 Latitude (degs), in record number two, would be populated with 

the same data from record number one.  The field VDM02 Latitude (degs), in record number two, 

would be populated with data read from the record number two VDM02 message.  The field VDM04 

Latitude (degs) would not be populated as messages number one and two do not contain data for this 

field.   

The message type for record number three (no shading – Table 6) is VDM03.  Using the Extract as 

Viewed feature, the field VDM01 Latitude (degs), in record number three, would be populated with 

the same data from record number one.  The field VDM02 Latitude (degs), in record number three, 

would be populated with the same data from record number two.  The VDM04 Latitude (degs) field 

would not be populated as messages number one, two, and three do not contain data for this field.   

The message type for record number four (peach shading – Table 6) is VDM04.  Using the Extract 

as Viewed feature, the field VDM01 Latitude (degs), in record number four, would be populated with 

the same data from record number one.  The field VDM02 Latitude (degs), in record number four, 

would be populated with the same data from record number two.  The field VDM04 Latitude (degs), 

in record number four, would be populated with data read from the record number four VDM04 

message. 

The message type for record number five (blue shading – Table 6) is VDM01.  Using the Extract as 

Viewed feature, the field VDM01 Latitude (degs), in record number five, would be populated with 

new data read from the record number five VDM01 message.  The field VDM02 Latitude (degs), in 

record number five, would be populated with the same data from record number two.  The field 

VDM04 Latitude (degs), in record number five, would be populated with same data from record 

number four.   

This process is repeated for each of the five remaining records.  To best understand the unique 

output format of the Extract as Viewed feature, a practical knowledge of AIS message field data is 

needed.  Also, the example in table 6 below uses distinct (VDM) message fields.  If the table view 

field selection in AISMiner contains “general” message fields (fields included in more than one 

message type), then a record-field will be populated with updated “general” field data each time a 

message containing the “general” field data is processed. 

Note:   See section 5.1.5.3 - Extract as Viewed (fresh data) for a comparison to the Extract as 

Viewed feature. 
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Table 6.  Extract as viewed menu item – record field population example. 

Column Fields  

in AISMiner  

Table View 

Last 

VDM 

Type 

VDM01 Latitude 

(degs) 

VDM02 Latitude 

(degs) 

VDM04 Latitude 

(degs) 

Contact 

[message] 

record # 1 

1 Populated    

2 2 
Populated (with data 

from record # 1) 
Populated  

3 3 
Populated (with data 

from record # 1) 

Populated (with data 

from record # 2) 
 

4 4 
Populated (with data 

from record # 1) 

Populated (with data 

from record # 2) 
Populated 

5 1 

Populated (updated 

with current message 

data) 

Populated (with data 

from record # 2) 

Populated (with data 

from record # 4) 

6 2 
Populated (with data 

from record # 5) 

Populated (updated with 

current message data) 

Populated (with data 

from record # 4) 

7 1 

Populated (updated 

with current message 

data) 

Populated (with data 

from record # 6) 

Populated (with data 

from record # 4) 

8 1 

Populated (updated 

with current message 

data) 

Populated (with data 

from record # 6) 

Populated (with data 

from record # 4) 

9 2 
Populated (with data 

from record # 8) 

Populated (updated with 

current message data) 

Populated (with data 

from record # 4) 

10 4 
Populated (with data 

from record # 8) 

Populated (with data 

from record # 9) 

Populated (updated 

with current 

message data) 

Note:  In addition to the standard output file, the feature also produces a separate csv file which 

includes statistical information about all receivers in the processed dataset.  This file is specific to 

R&D Center analyses and is named “XXX_RcvrStats.csv”. 

5.1.5.2.1 Example – Extract as Viewed 

The following example demonstrates the Extract as Viewed feature.  

1. Start AISMiner. 

2. From the View menu item, select Edit a View then View #1. 

3. To open the View Editor window, from the View menu item go to Edit a View and select 

View #1. 

4. Click the General Info radio button (red outline - Figure 38) then using the Add button (blue 

outline – Figure 38), select and add the fields Vessel ID, Rcvr ID, and Last VDM type to the 

Items in current view list (green outline – Figure 38).     
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Figure 38.  AISMiner – view editor window. 

5. Click the VDM 1 radio button and add the field VDM01 Latitude (degs) to the Items in 

current view list. 

6. Click the VDM 3 radio button and add the field VDM03 Longitude (degs) to the Items in 

current view list. 

7. Click the VDM 5 radio button and add the field VDM05 Name to the Items in current view 

list.   

8. Click the Ok button to close the View Editor window and update the table view in AISMiner 

(Figure 39).   

 

Figure 39.  AISMiner – custom table view. 
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9. From the Tools menu item verify that Apply Selected Filters is checked.  Note this step is 

optional. 

10. From the File menu item select Export then Extract as Viewed.   

11. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).      

12. In the Save As window, enter the file name “ExtractAsViewedTest1.csv” and click the Save 

button.  By default the file is saved to the application directory.  Note that a separate file, 

named “ExtractAsViewedTest1_RcvrStats.csv” is also created and saved by default. 

13. Click the Resume playback button to begin processing of the csv output file. 

14. Depending on the size of the saved log file, allow AISMiner to process the complete log file, 

or allow AISMiner a few seconds to process part of the log file then click the Stop playback 

button followed by the Quit playback button.   

15. Using Microsoft Excel, navigate to and open the ‘ExtractAsViewedTest1.csv” output file.  

Note, depending on your version of Excel you may need to change the open file selection to 

“All Files” to view files with a csv extension.  To view results as shown in table 6 above, sort 

(A to Z) first by the Vessel ID column then Rcvr ID.  Figure 40 below shows an example of 

the csv output file.   

 

Figure 40.  Excel – extract as viewed csv output file. 

5.1.5.3 Extract as Viewed (fresh data) 

The Extract as Viewed (fresh data) menu item is used to save processed data to a local or network 

directory.  The data is saved as an Excel ‘csv’ file.  The feature only works in saved data mode.  Like 

the Print Display to File feature (§ 5.1.4), only filtered data (based on settings in the Filter Editor 

window), and fields shown in the table view (based on settings in the View Editor window), are 

saved to the csv output file.  Unlike the Print Display to File feature, the csv file created is based on 

all processed message data, not just the most recently processed message data shown in the table 

view.   

Table 7 below shows an example of the record-field data population, in the csv output file, for a 

single contact/receiver pairing using the Extract as Viewed (fresh data) feature.  In the example, the 

table columns Last VDM type, VDM01 Latitude (degs), VDM02 Latitude (degs), and VDM04 

Latitude (degs) represent fields shown in the AISMiner table view.  In the example, a contact 
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transmitted ten messages to a receiver; which were processed by AISMiner.  The message type for 

each transmitted message is shown in the column Last VDM type.   

The message type for record number one (yellow shading – Table 7) is VDM01.  Using the Extract 

as Viewed (fresh data) feature, the field VDM01 Latitude (degs), in record number one, would be 

populated with data from the message, but not the fields VDM02 Latitude (degs), and VDM04 

Latitude (degs) as a VDM01 message does not contain data for these two fields.   

The message type for record number two (green shading – Table 7) is VDM02.  Using the Extract as 

Viewed (fresh data) feature, the field VDM01 Latitude (degs), in record number two, would be 

empty.  This is because the VDM02 message does not contain VDM01 Latitude (degs) field data 

and, unlike the Extract as Viewed feature (§ 5.1.5.2), the VDM01 Latitude (degs) field data from 

record number one are not used to populate this field in record number two.   The field VDM02 

Latitude (degs), in record number two, would be populated with data read from the record number 

two VDM02 message.  The field VDM04 Latitude (degs) would not be populated as a VDM02 

message does not contain data for this field.     

The message type for record number three (no shading – Table 7) is VDM03.  Using the Extract as 

Viewed (fresh data) feature, the fields VDM01 Latitude (degs), VDM02 Latitude (degs), and VDM04 

Latitude (degs), in record number three, would be empty.  This is because the VDM03 message does 

not contain VDM01 Latitude (degs), VDM02 Latitude (degs), or VDM04 Latitude (degs) field data 

and, unlike the Extract as Viewed feature, the applicable field data from records number one and two 

are not used to populate these fields in record number three.      

The message type for record number four (peach shading – Table 7) is VDM04.  Using the Extract 

as Viewed (fresh data) feature, the fields VDM01 Latitude (degs), and VDM02 Latitude (degs) in 

record number four, would be empty.  This is because the VDM04 message does not contain VDM01 

Latitude (degs) or VDM02 Latitude (degs) field data and, unlike the Extract as Viewed feature, the 

applicable field data from records number one and two are not used to populate these fields in record 

number four.  The field VDM04 Latitude (degs), in record number four, would be populated with 

data read from the record number four VDM04 message.    

The message type for record number five (blue shading – Table 7) is VDM01.  Using the Extract as 

Viewed (fresh data) feature, the field VDM01 Latitude (degs), in record number five, would be 

populated with data from this message, but not the fields VDM02 Latitude (degs), and VDM04 

Latitude (degs) as a VDM01 message does not contain data for these two fields and, unlike the 

Extract as Viewed feature, the applicable field data from records number two and four are not used 

to populate these fields in record number five.   

This process is repeated for each of the five remaining records.  To best understand the unique 

output format of the Extract as Viewed (fresh data) feature, a practical knowledge of AIS message 

field data is needed.  Also, the example in table 7 below uses distinct (VDM) message fields.  If the 

table view field selection in AISMiner contains “general” message fields (fields included in more 

than one message type), then a record-field will be populated with updated “general” field data each 

time a message containing the “general” field data is processed.  

Note:   See section 5.1.5.2 - Extract as Viewed for a comparison to the Extract as Viewed (fresh 

data) feature. 
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Table 7.  Extract as viewed (fresh data) menu item – record field population example. 

Column Field 

 in AISMiner 

Table View 

Last 

VDM 

Type 

VDM01 Latitude 

(degs) 

VDM02 Latitude 

(degs) 

VDM04 Latitude 

(degs) 

Contact 

[message] 

record # 1 

1 Populated   

2 2  Populated  

3 3    

4 4   Populated 

5 1 
Populated (updated with 

current message data) 
  

6 2  
Populated (updated with 

current message data) 
 

7 1 
Populated (updated with 

current message data) 
  

8 1 
Populated (updated with 

current message data) 
  

9 2  
Populated (updated with 

current message data) 
 

10 4   
Populated (updated with 

current message data) 

Note:  In addition to the standard output file, the feature also produces a separate csv file which 

includes statistical information about all receivers in the processed dataset.  This file is specific to 

R&D Center analyses and is named “XXX_RcvrStats.csv”. 

5.1.5.3.1 Example – Extract as Viewed (fresh data) 

The following example demonstrates the Extract as Viewed (fresh data) feature.  

1. Start AISMiner. 

2. From the View menu item, select Edit a View then View #1. 

3. To open the View Editor window, from the View menu item go to Edit a View and select 

View #1. 

4. Click the General Info radio button then using the Add button, select and add the fields 

Vessel ID, Rcvr ID, and Last VDM type to the Items in current view list.    

5. Click the VDM 1 radio button and add the field VDM01 Latitude (degs) to the Items in 

current view list. 

6. Click the VDM 3 radio button and add the field VDM03 Longitude (degs) to the Items in 

current view list. 

7. Click the VDM 5 radio button and add the field VDM05 Name to the Items in current view 

list.   
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8. Click the Ok button to close the View Editor window and update the table view in AISMiner.   

9. From the Tools menu item verify that Apply Selected Filters is checked.  Note this step is 

optional. 

10. From the File menu item select Export then Extract as Viewed (fresh data).   

11. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).       

12. In the Save As window, enter the file name “ExtractAsViewedFreshDataTest1.csv” and click 

the Save button.  By default the file is saved to the application directory.  Note that a separate 

file, named “ExtractAsViewedFreshDataTest1_RcvrStats.csv” is also created and saved by 

default. 

13. Click the Resume playback button to begin processing of the csv output file. 

14. Depending on the size of the saved log file, allow AISMiner to process the complete log file, 

or allow AISMiner a few seconds to process part of the log file then click the Stop playback 

button followed by the Quit playback button.   

15. Using Microsoft Excel, navigate to and open the ‘ExtractAsViewedFreshDataTest1.csv” 

output file.  Note, depending on your version of Excel, you may need to change the open file 

selection to “All Files” to view files with a csv extension.  To view results as shown in table 

7 above, sort (A to Z) first by the Vessel ID column then Rcvr ID.  Figure 41 below shows an 

example of the csv output file.   

 

Figure 41.  Excel – extract as viewed (fresh data) csv output file. 

5.1.5.4 Generate PRDC Sentences 

 

The Generate PRDC Sentences menu item is used to add expanded position data to message types 1, 

2, 3, and 5.  The feature works with saved log files.  The additional information is formatted in 

Proprietary Research and Development Center (PRDC) format.  Figure 42 below shows an output 

log file, opened in Excel, using this feature.  The processed message sentence data (blue highlight – 

Figure 42) is written first in the output sentence, followed by the expanded sentence data (peach 

highlight – Figure 42).  When field data is not included in the original message, the field appears 

blank or the letters “NA” are shown in the expanded section of the output sentence.      
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Figure 42.  Excel – generate PRDC sentences output log file. 

Following is an explanation of each expanded position statement type (red outline – Figure 42 

above).  The statement types are TAG, POS1, POS2, DRD1, SVD1, and SVD2. 

TAG:  Receiving (Base) Station and Time Tag for received AIS data. 

Provides the identity of the AIS [base] station, which received the associated message, and the date 

and time of message reception.  Also, the distance between the transmit vessel and receiving station 

at time of transmission is included when available (i.e., the VDM sentence contains vessel position 

information).  A TAG sentence immediately follows all “!AIVDM” sentences sent from a receiving 

station.   

Sentence Structure: 

$PRDC,TAG,a,b,c*hh 
 

Example: 

$PRDC,TAG,r003669971,1051761221,49.83*1C 
 

Sentence Parameters: 

• $P: Proprietary identifier of NMEA 0183 sentence.   

• RDC:  NMEA registered identifier of USCG R&DC. 

• TAG:  Statement type identifier.  The TAG sentence provides the receiving source identifier 

and time of AIS message reception. 

• a:  Receiver identifier.   

• b:  Time stamp from receiving station at receipt of VDM sentence.  Formatted as seconds 

elapsed since midnight on Jan 1, 1970.   

• c:  Distance from receiving station in nautical mile. 

• *:  Identifier denoting the following two characters as a checksum. 

• hh:  Two character checksum (x Or) value.  Applies to all message data between ‘$’ and 

second ‘*’ exclusive. 
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Note: When data is not available a null field is shown.  Two field delimiters (commas) without a 

separating space represent a null field.   

POS1:  Decoded AIS position report data. 

Provides the decoded and scaled values for the first thirteen parameters of ITU messages 1, 2, and 3.  

See POS2 statement type for the remaining fields.  

Sentence Structure: 

        $PRDC,POS1,a,b,c,d,e,f,g,h,i,j,k,l,m*hh 
 

Example: 

$PRDC,POS1,1,0,248143000,0,0,14.1,0,4031.220,N,7144.903,W,268.0,269.0*79 
  

Sentence Parameters: 

• $P: Proprietary identifier of NMEA 0183 sentence.   

• RDC:  NMEA registered identifier of USCG R&DC. 

• POS1:  Statement type identifier.  The POS1 sentence yields the majority of the decoded 

content of ITU messages 1, 2, or 3. 

• a:  User ID (MMSI Number). 

• b:  Navigational status (0-15). 

• c:  Rate of Turn  (+rot) = right turn, (-rot) = left turn (float). 

• d:  Speed Over Ground (SOG) in knots. 

• e:  Position accuracy. 

• f:  Latitude in degrees minutes decimal minutes. 

• g:  Latitude direction (N/S). 

• h:  Longitude in degrees minutes decimal minutes. 

• i:  Longitude direction (E/W). 

• j:  Course Over Ground (COG) in degrees. 

• k:  True Heading in degrees (integer) 

• *:  Identifier denoting the following two characters as a checksum. 

• hh:  Two character checksum (x Or) value.  Applies to all message data between ‘$’ and 

second ‘*’ exclusive. 
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POS2:  Decoded AIS position report data. 

Provides the decoded and scaled values for the last five parameters of ITU messages 1, 2, and 3.  See 

POS1 statement type for the first thirteen fields.  

Sentence Structure: 

$PRDC,POS2,a,b,c,d,e,f,g,h,i,j,k,l,m,n*hh 
 

Example: 

$PRDC,POS2,1,0,,0,0,0,2,,2249,,,,,*59 
 

Sentence Parameters: 

• $P: Proprietary identifier of NMEA 0183 sentence.   

• RDC:  NMEA registered identifier of USCG R&DC. 

• POS2:  Statement type identifier.  The POS2 sentence provides remaining decoded fields 

content of ITU messages 1, 2, or 3. 

• a:  Time Stamp in seconds (0-59). 

• b:  Positioning system problem indicator.1 

• c:  Regional application (0-15). 

• d:  Spare (0-1). 

• e:  RAIM flag (0-1). 

• f:  Sync state.2 

• g:  SOTDMA slot timeout.3 

• h:  SOTDMA received stations.4 

• i:  SOTDMA slot number.5 

• j:  SOTDMA UTC time - formatted as “hhmm.”6 

• k:  SOTDMA slot offset.7 

• l:  ITDMA slot increment.8 

• m:  ITDMA number of slots.9 

• n:  ITDMA keep flag (T/F).10 

• *:  Identifier denoting the following two characters as a checksum. 

• hh:  Two character checksum (x Or) value.  Applies to all message data between ‘$’ and 

second ‘*’ exclusive. 
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1. The Positioning System Problem Indicator is determined by the values of 61-63 as contained 

in the Time Stamp data in the VDM sentence.  This field is set to null if no problems are 

reported, i.e. a value below 61 is contained in the time stamp data in the VDM sentence:     

M = Manual input mode. 

E = Estimated (dead reckoning) mode. 

N = Inoperative - not valid. 

2. The Sync State is a component of the ITDMA and SOTDMA Communications States and 

identifies the type of TDMA synchronization be used by the AIS equipment.  It may consist 

of the following values: 

  0 = UTC direct. (See ITU-R M.1371-3 sec 3.1.1.1) 

  1 = UTC indirect. (See ITU-R M.1371-3 sec 3.1.1.2) 

  2 = Station is synchronized to a base station. (See ITU-R M.1371-3 sec 3.1.1.3) 

3 = Station is synchronized to another station based upon the highest number of 

received station. (See ITU-R M.1371-3 sec 3.1.1.4) 

3. The Slot Time-out is a component of the SOTDMA Communications State (ITU messages 1 

and 2) and specifies the number of frames remaining until a new slot is selected.  This field is 

null for the ITDMA Communications State found in ITU message 3.  The range of data is 

from 0 to 7. 

4. The Received Stations field is a component of only the SOTDMA Communications State 

(ITU messages 1 and 2) and specifies the number of other AIS units which are currently 

being received.  This field shall contain data only when the SOTDMA Slot Time-out field is 

set to 3, 5, or 7, and shall be null otherwise.  The range of data is from 0 to 16383.  

5. The Slot Number field is a component of only the SOTDMA Communications State (ITU 

messages 1 and 2) and specifies the slot number used for this transmission.  This field shall 

contain data only when the SOTDMA Slot Time-out field is set to 2, 4, or 6, and shall be null 

otherwise.  The range of data is from 0 to 2249.  

6. The UTC field is a component of only the SOTDMA Communications State (ITU messages 

1 and 2) and specifies the hour and minute of the current frame.  Units of seconds are not 

provided. This field shall contain data only when the SOTDMA Slot Time-out field is set to 

1 and shall be null otherwise. 

7. The Slot Offset field is a component of only the SOTDMA Communications State (ITU 

messages 1 and 2) and specifies relative jump to the slot in which transmission will occur 

during the next frame.  This field shall contain data only when the SOTDMA Slot Time-out 

field is set to 0 and shall be null otherwise. 

8. The Slot Increment field is a component of only the ITDMA Communications State (ITU 

message 3) and specifies the offset to the next slot to be used.  This field shall contain data 

only when this is an ITDMA Communications State (ITU message 3) and shall be null 

otherwise. 

9. The Number of Slots field is a component of only the ITDMA Communications State (ITU 

message 3) and specifies the number of consecutive slots for reserve.  This field shall contain 

data only when this is an ITDMA Communications State (ITU message 3) and shall be null 

otherwise. 
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10. The Keep Flag field is a component of only the ITDMA Communications State (ITU 

message 3) and is set to T for True if the slot remains allocated for one additional frame, 

otherwise the field is set to F for False.  This field shall contain data only when this is an 

ITDMA Communications State (ITU message 3) and shall be null otherwise. 

Note: A null field indicates data not available.  A forward slash “/” character at the beginning of a 

line indicates that the sentence is continued from the previous line.  A forward slash “/” character at 

the end of a line indicates that the sentence is continued on the next line. 

DRD1:  Data derived from decoded AIS position report data (POS1 and POS2). 

Provides additional data derived from the basic information contained in the AIS broadcast and 

information provided by the AIS receiving station.    

Sentence Structure: 

$PRDC,DRD1,a*hh 
 

Example: 

$PRDC,DRD1,1051761221*62 
  

Sentence Parameters: 

• $P: Proprietary identifier of NMEA 0183 sentence.   

• RDC:  NMEA registered identifier of USCG R&DC. 

• DRD1:  Statement type identifier.  The DRD1 sentence contains derived information. 

• a:  Reconstructed Navigation Solution Time of the vessel position reported in the associated 

AIS VDM sentence.  Seconds elapsed since midnight January 1, 1970 GMT.  This is an 

integer field.  This field will be null when the value is not available (i.e., AISMiner does not 

have enough raw AIS data to derive this information, such as when the first vessel report is 

received.) 

• *:  Identifier denoting the following two characters as a checksum. 

• hh:  Two character checksum (x Or) value.  Applies to all message data between ‘$’ and 

second ‘*’ exclusive. 

SVD1:  Decoded AIS ship static and voyage data. 

Provides decoded and scaled values for the first seven parameters of ITU message 5.  See the SVD2 

statement type for the remaining eleven fields.  

Sentence Structure: 

$PRDC,SVD1,a,b,c,d,e,f,g,h*hh 
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Example: 

$PRDC,SVD1,5,0,248143000,0,248143000,WDD4003,BOCA_GRANDE,52*2D 
 

Sentence Parameters: 

• $P: Proprietary identifier of NMEA 0183 sentence.   

• RDC:  NMEA registered identifier of USCG R&DC. 

• SVD1:  Statement type identifier.  The SVD1 sentence yields the first seven parameters from 

ITU message 5. 

• a:  message ID (5). 

• b:  Repeat indicator. 

• c:  User ID (MMSI number). 

• d:  AIS version indicator (0 – 3). 

• e:  IMO number (from message Type 5). 

• f:  Call sign (1 – 7 characters). 

• g:  Vessel name (1 – 20 characters). 

• h:  Ship and cargo type number.  

• *:  Identifier denoting the following two characters as a checksum. 

• hh:  Two character checksum (x Or) value.  Applies to all message data between ‘$’ and 

second ‘*’ exclusive. 

SVD2:  Decoded AIS ship static and voyage data. 

Provides the decoded and scaled values for the last eleven parameters of ITU message 5.  See the 

SVD1 statement type for the first seven fields.  

Sentence Structure: 

$PRDC,SVD2,a,b,c,d,e,f,g,h,i,j,k*hh 
 

Example: 

$PRDC,SVD2,112,252,28,15,1,2406,122003.44,34.5,PT_EVERGLADES,1,0*6B 
  

Sentence Parameters: 

• $P: Proprietary identifier of NMEA 0183 sentence.   

• RDC:  NMEA registered identifier of USCG R&DC. 

• SVD2:  Statement type identifier.  The SVD2 sentence yields the last eleven parameters from 

ITU message 5. 
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• a:  Pos. ref. point distance, "A," from bow 1 (0 to 511 m).  

• b:  Pos. ref. point distance, "B," from stern 1 (0 to 511 m).  

• c:  Pos. ref. point distance, "C," from port beam 1 (0 to 63 m). 

• d:  Pos. ref. point distance, "D," from starboard beam 1 (0 to 63 m). 

• e:  Type of electronic position fixing device.2 

• f:  ETA date formatted as “ddmm”. 

• g:  ETA time. 

• h:  Draft. 

• i:  Destination (1 – 20 characters). 

• j:  DTE (0=available 1=not available). 

• k:  Spare bit. 

• *:  Identifier denoting the following two characters as a checksum. 

• hh:  Two character checksum (x Or) value.  Applies to all message data between ‘$’ and 

second ‘*’ exclusive. 

1. These are the four dimensions from the bow, stern, port beam, and starboard beam to the 

horizontal reference point on the ship for which the current "position reports" are valid.  The 

sum of A + B is the length of the ship in meters, and the sum of C + D is the width of the 

ship in meters.  Refer to the ITU-R M.1371 message 5, "Reference Point for reported 

position and Dimensions of Ship."  If the reference point of "reported position" is not 

available, but the dimensions of the ship are available: A = C = 0 and B > 0 and D > 0.  If 

neither the reference point for the reported position nor the dimensions of the ship are 

available: A = B = C = D = 0 (default).  Use of a null field for A, B, C, and/or D indicates 

that the previously entered dimension for that parameter is unchanged.  In many cases, the 

ship's reference point for "reported position" will be the location of the positioning antenna.  

Distance is in meters 

A & B = 0 – 511m 

C & D = 0 – 63m, 63 if > 63m 

   

Figure 43.  AIS – position/dimension message reference point. 
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2. The type of electronic position fixing device is as follows: 

1 = GPS 

2 = GLONASS 

3 = combined GPS/GLONASS 

4 = Loran-C 

5 = Chayka 

6 = Integrated navigation system. 

7 = Surveyed 

8-15 = Not currently defined. 

5.1.5.4.1 Example – Generate PRDC Sentences 

The following example demonstrates the Generate PRDC Sentences feature.  

1. Start AISMiner. 

2. From the File menu item select Export then Generate PRDC Sentences.  Note that it is not 

necessary to adjust the table view or filter editor settings as this will not affect the output file. 

3. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).      

4. In the Save File window, enter the file name “GeneratePRDCSentencesTest1.log” and click 

the Save button.  By default the file is saved to the application directory. 

5. Click the Resume playback button to begin processing of the filtered output file. 

6. Depending on the size of the saved log file, allow AISMiner to process the complete log file, 

or allow AISMiner a few seconds to process part of the log file then click the Stop playback 

button followed by the Quit playback button.   

7. Using Notepad or Microsoft Excel, navigate to and open the 

“GeneratePRDCSentencesTest1.log” output file.  Note, depending on your version of Excel, 

you may need to change the open file selection to “All Files” to view files with a csv 

extension.   Figure 44 below shows an example of the output log file in Notepad.    

 

Figure 44.  Notepad – generate PRDC sentences output log file. 
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5.1.5.5 Convert to SIM Format 

Important:  The Convert to SIM Format menu feature is considered obsolete, and has been replaced 

by Extract as Viewed. 

Universal Automatic Identification System (UAIS) Simulation is a simulation application developed 

by the R&D Center, and used to model the AIS for analysis purposes.  When originally developed, 

UAIS Simulation only read data custom formatted by AISMiner, and saved with an “amo” file 

extension.  The newest version of UAIS Simulation reads Microsoft Excel “csv” files, which 

AISMiner outputs using the Extract as Viewed menu item.   

5.1.5.6 Echo and Expand 

The Echo and Expand menu item, similar to the Generate Filtered Output (§ 5.1.5.1) feature, is used 

to append AISMiner processed message data to original message data to form a single message 

sentence.  The feature works with saved log files and outputs an Excel csv file.  Only fields from the 

active table view in AISMiner are included in the output file’s dataset.  The original message 

sentence data (yellow highlight – Figure 45) is written first in the output sentence, followed by the 

processed sentence (blue highlight – Figure 45), and finally the expanded sentence data (peach 

highlight – Figure 45).  When field data is not included in the original message, the field appears 

blank or the letters “NA” are shown in the expanded section of the output sentence.     

Note:  This application feature is used mainly by the R&D Center for internal analysis work. 

 

Figure 45.  Excel – echo and expand output csv file. 

5.1.5.6.1 Example – Echo and Expand 

The following example demonstrates the Echo and Expand feature.  

1. Start AISMiner. 

2. From the File menu item select Export then Echo and Expand.  Note that it is not necessary 

to adjust the table view as this will not affect the output file. 

3. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).       

4. In the Save File window, enter the file name “EchoAndExpandTest1.log” and click the Save 

button.  By default the file is saved to the application directory. 

5. Click the Resume playback button to begin processing of the filtered output file. 
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6. Depending on the size of the saved log file, allow AISMiner to process the complete log file, 

or allow AISMiner a few seconds to process part of the log file then click the Stop playback 

button followed by the Quit playback button.   

7. Using Microsoft Excel, navigate to and open the “EchoAndExpandTest1.csv” output file 

(Figure 45 above).  Note, depending on your version of Excel, you may need to change the 

open file selection to “All Files” to view files with a csv extension.        

5.1.6 Exit 

Updates all application support files with changes made during the open application session and 

closes the AISMiner application. 

5.2 View  

Menu Items: 

• Default. 

• View # (1 through 4). 

• Edit a view. 

o View # (1 through 4) 

AISMiner displays processed message data using a spreadsheet style table view.  A user can view 

data using the application’s default view or one of four user defined views.  At application start-up, 

AISMiner reads view settings saved in the AISMiner INI file and opens with the last used view.  At 

application shutdown, AISMiner saves changes made to user defined views to this INI file.     

Important:  Other than the Extract as Viewed and Extract as Viewed (fresh data) save operations, 

table fields (column headers) shown in a view do not affect data saved during an Export (§ 5.1.5) file 

operation.  All field data, which are part of original messages, are saved.  

5.2.1 Default 

The Default menu item sets the table view to a standard view.  This view cannot be customized by a 

user.   

5.2.2 View # (1 - 4) 

The View # menu items set the table view to a custom view defined by a user.  Custom views are 

created using the View Editor window. 

5.2.3 Edit a View 

The Edit a View menu item opens the View Editor window.  Creating custom views is done using 

the View Editor window.  The View Editor window is made up of table view fields, which are 

associated with fields from AIS message types.   
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5.2.3.1 Example – Edit a View 

The following example provides instructions for creating a custom view using the View Editor 

window.  Note that user defined views can be edited at anytime in either live or saved data mode.   

1. Start AISMiner. 

2. From the View menu item select View #1.      

3. From the File menu item select Open File.   

4. To open the View Editor window, from the View menu item go to Edit a View and select 

View #1 (Figure 46).   

 

Figure 46.  AISMiner – edit a view sub-menu items. 

5. To display a list of data fields not specific to an AIS message, in the View Editor window 

click the General Info radio button (red outline - Figure 47).   
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Figure 47.  AISMiner – view editor window. 

6. Using the Add button (blue outline – Figure 47 above), select and add fields to the Items in 

current view list.   

7. Repeat step six using fields from different radio button items (e.g., VDM 1 through 24).   

8. Click the Ok button to close the View Editor window and update the table view in AISMiner 

(Figure 48).  Selected fields appear in the table view in the order shown in the Items in 

current view list.  To change the order, use the Add and Remove buttons.  For more control 

over the order of fields, click on a field in the Items in current view list to highlight it then 

click on a field in the Selectable items list and add it to the Items in current view list.  Note 

that it appears before the highlighted field selected in the Items in current view list.    

 

Figure 48.  AISMiner – custom table view. 
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5.3 Tools 

Menu Items: 

• Edit filters. 

• Apply selected filters. 

• Edit receiver info view. 

• View receiver info. 

5.3.1 Edit Filters 

The Edit Filters menu item opens the Filter Editor window.  AISMiner provides the option to filter 

data in both live and saved data mode.  Creating custom data filters is done using the Filter Editor 

window.  The Filter Editor window is made up of the following nine main sections (blue outline – 

Figure 49):   

• Statement types. 

• Receivers. 

• Vessels. 

• Bounded region. 

• Speed. 

• Range. 

• Bearing. 

• Time (UTC). 

• Line number. 

Filter control (i.e., true/false, on/off) for each section is governed by selecting one of three radio 

buttons (green outline – Figure 49).  When the Allow Selected radio button is selected (true), only 

messages with field values meeting parameters set in that section are processed.  When the Disallow 

Selected radio button is selected (false), all messages, except those with field values meeting 

parameters set in that section, are processed.  When the Disable Filter radio button is selected (off), 

message data filtering for that section is not performed.  Filter testing is executed in the following 

order:    

1. If not disabled, by Line Number; 

2. If not disabled, by Statement Types; 

3. If not disabled, by Receivers; 

4. If not disabled, by Vessels; 
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5. If not disabled, by Bounded Region; 

6. If not disabled, by Bearing; 

7. If not disabled, by Range; 

8. If not disabled, by Speed; 

9. If not disabled, by Time (UTC). 

Important:  It is important to understand the effect of filter execution order when performing 

custom data filtering.  For example, if the main objective of a custom data filter is to view specific 

vessels during a specific time period, then, at a minimum, all filter sections executed before the 

Vessels section (i.e., Line Number, Statement Types, and Receivers) should be disabled.  If the 

objective is to only view specific vessels during a specific time period, then all sections, other than 

Vessels and Time (UTC), should be disabled.  

 

Figure 49.  AISMiner – filter editor window. 
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5.3.1.1 Example – Edit Filters  

The following example demonstrates a three step filter operation in saved data mode.   

1. Start AISMiner. 

2. From the View menu item select Default.  

3. From the Tools menu item verify that Apply Selected Filters is not checked.   

4. From the File menu item select Open File.   

5. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).       

6. To populate the Filter Editor window (Figure 49 above) Known Receivers and Vessel lists, 

click the Resume button.  After a few seconds click the Stop button to stop data processing.    

7. To open the Filter Editor window, from the Tools menu item select Edit Filters.  

8. In the Statements Types section, click the Allow Selected button (red outline – Figure 49 

above).  Leave the default VDM message selections checked. 

9. In the Receivers section (Figure 50), click the Allow Selected button.  Using the Add button 

(blue outline - Figure 50), move a receiver from the Known list to the Selected list.   

 

Figure 50.  AISMiner – filter editor window – receivers section. 

10. In the Speed section (Figure 51), click the Allow Selected button.   Using the up and down 

arrow buttons, change the Faster Than value to 2.5 knots and the Slower Than value to 99.0 

knots.  Note that the values can also be typed directly into the textbox.   
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Figure 51.  AISMiner – filter editor window – speed section. 

11. Confirm that all other sections have Disable Filter radio button selected. 

12. To close the Filter Editor window and save custom filter settings, click the Ok button. 

13. To apply the filter settings to the open log file, from the Tools menu item select Apply 

Selected Filters.    

14. To view filtered results (Figure 52), click the Restart then Resume playback buttons.   

 

Figure 52.  AISMiner – filtered data. 

Note:  Viewing a log file using custom filter settings does not change the underlying data.   

Note:  See section 5.1.5.1 to generate and save a filtered log file.    
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5.3.2 Apply Selected Filters 

The Apply Selected Filters menu item is used to apply filter settings, set using the Filter Editor 

window (§ 5.3.1), to data being processed.  The menu selection functions as an on/off switch.  Click 

the Apply Selected Filters menu item once to turn the feature on (indicated by a check mark), and a 

second time to turn it off.  Apply Selected Filters is accessed from the Tools menu item (Figure 53). 

 

Figure 53.  AISMiner – apply selected filters menu item. 

5.3.3 Edit Receiver Info View 

The Edit Receiver Info View menu item opens the Receiver View Editor window.  This window is 

used to edit which fields, and in what order, are shown in the Receiver View window (§ 5.3.4).   

Changes made using the Receiver View Editor window remain constant through separate application 

sessions.   

5.3.3.1 Example – Edit Receiver Info View 

The Receiver View window table view can be edited at anytime in either live or saved data mode.  

The following example provides instructions for editing the table view in saved data mode.  

1. Start AISMiner. 

2. From the File menu item select Open File.   

3. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner INI file setting LogDir (§ 4.1.1.10).     

4. To open the Receiver View Editor window, from the Tools menu item select Edit Receiver 

Info View (Figure 54).    

 

Figure 54.  AISMiner – edit receiver info view menu item. 
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5. Using the Add button (red outline – Figure 55), select and add new fields to the Items to view 

list.   

 

Figure 55.  AISMiner – receiver view editor window. 

6. Click the Ok button to close the Receiver View Editor window and update the table view in 

Receiver View window.  Selected fields will appear in the Receiver View window in the 

order shown in the Items to view list.  To change the order, use the Add and Remove buttons.  

For more control over the order of fields, click on a field in the Items to view list to highlight 

it then click on a field in the View items available list and add it to the Items to view list.  

Note that it appears before the highlighted item selected in the Items to view list.    

Note:  See section 5.3.4 - View Receiver Info to see saved changes in the Receiver View window. 

Note:  See section 7 - Receiver View Window – Table View for a description of each field listed in 

the Receiver View Editor window. 

5.3.4 View Receiver Info 

The View Receiver Info menu item opens the Receiver View window (Figure 56).  This window uses 

a spreadsheet style table view to displays receiver specific information from a live or saved dataset.  

To customize the Receiver View window table view, follow instructions outlined in section 5.3.3 - 

Receiver View Editor window.    
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Figure 56.  AISMiner – receiver view window. 

5.4 Options  

Menu Items: 

• Pin to top. 

• Enable live mode logging. 

5.4.1 Pin to Top 

The Pin to Top menu item is used to keep the AISMiner application on top of all other open 

applications.   The menu selection functions as an on/off switch.  Click the Pin to Top menu item 

once to turn the feature on (indicated by a check mark), and a second time to turn it off.  Pin to Top 

is accessed from the Options menu item (Figure 57). 

 

Figure 57.  AISMiner – pin to top menu item. 

5.4.2 Enable Live Mode Logging 

The Enable Live Mode Logging menu item is used to save data, processed from a live AIS data 

stream, to a daily log file.  The data saved remains in original form.  The feature works while 

AISMiner is simultaneously processing a live data stream using filters and other application settings.  

The menu selection functions as an on/off switch.  Click the Enable Live Mode Logging menu item 
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once to turn the feature on (indicated by a check mark), and a second time to turn it off.  Saved log 

files can be opened for processing by AISMiner or viewed using Transview.  This feature works in 

conjunction with the AISMiner INI file setting Log data in live mode (§ 4.1.1.9).  Figure 58 below 

shows a [unprocessed] log file saved using this feature. 

 

Figure 58.  Notepad – live mode log file. 

5.4.3 Medler 

The Medler menu item provides three menu options for controlling the playback speed of saved log 

files (Figure 59).     

 

Figure 59.  AISMiner – Medler menu options. 

5.4.3.1 Insert Medler Into Live Data 

The Insert Medler Into Live Data menu item is used to insert a time tag and source ID, formatted to 

TAG Block, after the last TAG Block and prior to the start of a NMEA sentence on the first line of 

each message group in a live data stream.  The Tag Block data serves as a marker when using the 

Use Medler for playback feature (§ 5.4.3.2).  This step is necessary to provide an accurate and 

consistent playback of saved data.   

Due to variances between (AISSource) message time stamps from different receiver sites, messages 

received only a second apart from different receivers could have time stamps indicating that they 
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were received by AISSource several seconds apart; though their order in the live data stream would 

be sequential.   The Insert Medler Into Live Data feature adjusts for this potential discrepancy by 

placing a separate timestamp at the end of the first sentence of each message group based on time of 

message receipt by AISMiner.   

For example: 

Message 1 has a timestamp of 10:00:00 and was received by AISMiner at 10:00:03 

Message 2 has a timestamp of 10:00:05 and was received by AISMiner at 10:00:04 

Message 3 has a timestamp of 10:00:02 and was received by AISMiner at 10:00:05  

Assuming playback at normal speed (real-time), message 1 would display first in AISMiner table 

view, at the playback time of (00:00:00), followed by message 2 at (00:00:01), and then message 3 at 

(00:00:02).   

Original “live” message sentence: 

/g:1-2-7,s:receiver1,c:123456789*60//s:receiver2,c:123456790*2E/!AIVDM.....\r\n 

/g:2-2-7*6A/$ARVSI...\r\n 

 

Same sentence with Medler timestamp added:  

/g:1-2-,s:receiver1,c:123456789*60//s:receiver2,c:123456790*2E//s:AISMiner,c:123456791*02/ 

!AIVDM.....\r\n 

/g:2-2-7*6A/$ARVSI...\r\n  

5.4.3.1.1 Example – Insert Medler Into Live Data 

The following example demonstrates the Insert Medler Into Live Data feature.  

1. Start AISMiner. 

2. From the View menu item select Default.  Note that this step is optional.   

3. From the Options menu item verify that Enable Live Mode Logging is checked.   

4. From the Options menu item select Medler then verify that Insert Medler Into Live Data is 

checked (Figure 60).   

 

Figure 60.  AISMiner – insert Medler into live data menu item. 

5. From the File menu item select Read Live Data.  Within a few seconds AISMiner starts 

processing the live data steam.   

6. To stop the Read Live Data process, from the File menu item select Exit. 
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5.4.3.2 Use Medler for Playback 

The Use Medler for playback menu item is used to playback a saved log file, marked with Medler 

timestamps (§ 5.4.3.1), at a set multiple of real-time.  The feature mimics the fast forward capability 

of video/audio components.  The “fast forward” multiplier is set using the Medler Step Editor 

window (§ 5.4.3.3).  For example, to view one hour of real-time data in ten minutes you would set 

the playback step value to 6.  This instructs AISMiner to display six seconds worth of log file data 

for every one second of real-time.   

5.4.3.2.1 Example – Use Medler for Playback 

The following example demonstrates the Use Medler for playback feature.  Note that this example 

requires use of the saved log file created in example 5.4.3.1.1 - Insert Medler Into Live Data above. 

1. Start AISMiner. 

2. From the View menu item select Default.    

3. From the Tools menu item verify that Apply Selected Filters is checked.  Note that this step is 

optional. 

4. From the File menu item select Open File.   

5. Using the Open file window, navigate to and open the log file saved in example 5.4.3.1.1 

above.  Log files are kept in the directory listed in the AISMiner INI file setting LogDir (§ 

4.1.1.10).     

6. From the Options menu item select Medler then verify that Use Medler for playback is 

checked (Figure 61).   

 

Figure 61.  AISMiner – use Medler for playback menu item. 

7. To open the Medler Step Editor window, from the Options menu item select Medler then 

click Set Medler playback step.   

8. Using the Medler Step Editor window, change the default value from 1 to 3.  Click the Ok 

button to save your changes. 

9. Click the Resume button to begin “three-time” fast forward playback of the saved log file. 

5.4.3.3 Set Medler Playback Step 

The Set Medler playback step menu item opens the Medler Step Editor window.  This window is 

used to set the “fast forward” multiplier playback speed of a saved log file created using the Insert 

Medler Into Live Data feature (§ 5.4.3.1).  The Medler Step Editor window is used in conjunction 
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with the Use Medler for playback feature (§ 5.4.3.2).  Changes made using the Medler Step Editor 

window do not remain constant through separate application sessions.   

5.4.3.3.1 Example – Set Medler Playback Step 

The following example provides instructions for editing the Medler step value.   

1. Start AISMiner. 

2. To open the Medler Step Editor window, from the Options menu item select Medler then 

click Set Medler playback step (Figure 62).   

 

Figure 62.  AISMiner – set Medler playback step menu item. 

3. Using the Medler Step Editor window, change the Medler step (default) value from 1 to 3 

(Figure 63).  Click the Ok button to save your changes. 

 

Figure 63.  AISMiner – Medler step editor window. 

5.5 Help 

Menu Items: 

• About. 

5.5.1 About 

Displays the About AISMiner window (Figure 64). 

 

Figure 64.  AISMiner – about window. 
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6 MAIN INTERFACE - TABLE VIEW 

Following is a list of fields, in alphabetical order, and their associated definitions, viewable in the 

table view of the AISMiner main interface.   

Note:  See section 5.2 for information on how to customize the table view of AISMiner main 

interface. 

Important:  For fields displaying values calculated over a period of time, in live data mode the 

period of time consists of one day beginning at midnight local machine time.  In saved data mode, 

the period of time spans the length of the dataset. 

6.1 Addressed Flag 

Report Unit:  0 or 1 

The Addressed flag field is used to indicate whether the message is a broadcast message or an 

addressed message. The format is: 0 = broadcast geographical area message = default; 1 = addressed 

message (to individual stations). 

6.2 Addressed Station ID 1 

Report Unit:  Number 

The MMSI number of an addressed station listed in message 22. 

6.3 Addressed Station ID 2 

Report Unit:  Number 

The MMSI number of an addressed station listed in message 22. 

6.4 Age of Pos Rpt 

Report Unit:  Seconds 

The Age of Pos Rpt field displays the number of seconds elapsed since the last position report from a 

contact.  The value is calculated by comparing the time value from the message time tag with local 

machine time and determining the difference.   

For example, if local machine time reads 1330 on 2 January, 2010 and the message time tag reads 

1329 on 1 January, 2010 this field displays a value of 60, ignoring the difference in dates. 

6.5 Aid to Nav Type  

Report Unit:  Number 

The Aid to Nav Type field is used in message 21 to distinguish what type of aid to navigation is used.  

The format is 0 = not available = default; 1-15 = fixed aid to navigation; 16-31 = floating aid-to-

navigation. 
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6.6 AIS Version  

Report Unit:  Number 

The AIS Version field is used in message 5 to indicate the station’s compliance with the current AIS 

version.  The format is: 0=station compliant with AIS edition 0; 1-3 = station compliant with future 

AIS editions 1, 2, and 3.  

6.7 Altitude (GNSS)(m) 

Report Unit:  Number 

The Altitude (GNSS)(m) field is used when a receiver site is aboard an airplane.  The altitude of the 

receiver site measured in meters above mean sea level (as derived from GNSS) is displayed in the 

Altitude (GNSS)(m) field.  The format is: 0-4094 m, 4095 = not available, 4094 = 4094 meters or 

higher. 

6.8 Application ID   

Report Unit:  Number 

The Application ID field shows the first 16 bits of binary message data.  The Application ID field is 

used to indicate if the message is for regional or local application.  It is also used for local testing 

and to identify when the message has global relevance.  Note that for messages 25 and 26 this field 

may be blank depending on the Binary data flag field value.  If the Binary data flag field has a value 

of zero (0), the Application ID field will be blank.   

Note:  For a more comprehensive description, see NMEA 0183 v4.0. 

6.9 Beam 

Report Unit:  Meters 

The measurement of a vessel at its widest point from side to side is its beam.  The Beam field value 

is displayed in meters between 0 and 126.  This value is extracted from the Dimension/Reference for 

Position field of message 5 and the Dimension of Ship/Reference for Position field of message 19. 

6.10 Bearing 

Report Unit:  Integer 

Bearing is the horizontal direction from the land based receiver site to the contact.  The position of 

the land based receiver site and a valid position report are required for AISMiner to calculate 

bearing.  When both are present, a bearing calculation is performed and the Bearing field value is 

updated. 

6.11 Binary Data Flag 

Report Unit:  Number (1 or 0) 
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The Binary data flag field specifies whether the binary data in messages 25 and 26 are unstructured 

or coded as defined by the sixteen bit application identifier contained within the message.   

Note:  For a more comprehensive description, see NMEA 0183 v4.0. 

6.12 Bit Count 

Report Unit:  Integer 

The Bit count field contains the total number of bits in a message.  It is used to verify that the 

number of bits in a message is equal to the [message] bit size specified in NMEA 0183 v4.0. 

6.13 Call Sign  

Report Unit:  Text 

A call sign is a unique combination of letters and numbers assigned to a radio communication user to 

identify a station.  Each contact has an associated call sign, which is displayed in the Call Sign field.  

The Call Sign field value is updated when a message 5 is processed. 

6.14 Cargo Type 

Report Unit:  Text 

The type of cargo that a contact is carrying is displayed in the Cargo Type field.  The Cargo Type 

field value is updated when a message 5 or 19 is processed.  If a message 5 or 19 has not been 

processed, the contact’s Cargo Type field is left blank. 

6.15 Channel A 

Report Unit:  Number 

The Channel A field displays the Channel A number for a designated area.  The value is read from 

message type 22.   

6.16 Channel A Bandwidth  

Report Unit:  0 or 1 

The format is 0 = default (as specified by channel number), 1=12.5 kHz bandwidth. 

6.17 Channel B 

Report Unit:  Number 

The Channel B field displays the Channel B number for a designated area.  The value is read from 

message type 22.   

6.18 Channel B Bandwidth  

Report Unit:  0 or 1 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  72 

The format is 0 = default (as specified by channel number), 1=12.5 kHz bandwidth. 

6.19 COG  

Report Unit:  1/10 increments  ( 0 < 360) 

Course Over Ground (COG) is the direction a contact is moving over the earth’s surface.   Messages 

1, 2, 3, 18, and 19 contain COG information.  The COG field is reported in 1/10 increments, from 0 

to 359.9. 

6.20 Cumulative Range 

Report Unit:  Nautical Miles  

The Cumulative Range field value is determined by taking the sum of all range values, calculated in 

a receiver/vessel pairing over a period of time, and dividing by the total number of range 

calculations. 

6.21 Current System Time (GMT) 

Report Unit:  HH:MM:SS 

The Current System Time (GMT) field displays the local machine time converted to GMT. 

6.22 Current System Time (local) 

Report Unit:  HH:MM:SS 

The Current System Time (local) field displays the local machine time.   

6.23 Current System Time (POSIX) 

Report Unit:  Number 

The Current System Time (POSIX) field displays the number of seconds elapsed since midnight, 

January 1, 1970 GMT. 

6.24 Date Tag First Rpt (GMT) 

Report Unit:  Day of the Week 

The Date tag first rpt (GMT) field displays the day of the week part of the time tag of the first vessel 

report for a given day.   During processing, AISSource assigns a Coordinated Universal Time (UTC) 

formatted time tag to each message received.  AISMiner converts this UTC value to Greenwich 

Mean Time (GMT) before displaying the date part in the Date tag first rpt (GMT) field.  A new day 

begins at midnight local time.  This field is updated when a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is 

processed. 

Note:  See also Time tag first rpt (GMT). 
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6.25 Date Tag First Rpt (local)  

Report Unit:  Day of the Week 

The Date tag first rpt (local) field displays the day of the week part of the time tag of the first vessel 

report for a given day.   During processing, AISSource assigns a Coordinated Universal Time (UTC) 

formatted time tag to each message received.  AISMiner converts this UTC value to local (host) 

machine time before displaying the date part in the Date tag first rpt (local) field.  A new day begins 

at midnight local time.  This field is updated when a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is 

processed. 

Note:  See also Time tag first rpt (local). 

6.26 Date Tag Last Rpt (GMT)  

Report Unit:  Day of the Week 

The Date tag last rpt (GMT) field displays the day of the week part of the time tag of the last vessel 

report for a given day.  During processing, AISSource assigns a Coordinated Universal Time (UTC) 

formatted time tag to each message received.  AISMiner converts this UTC value to Greenwich 

Mean Time (GMT) before displaying the date part in the Date tag last rpt (GMT) field.  A new day 

begins at midnight local time.  This field is updated when a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is 

processed. 

Note:  See also Time tag last rpt (GMT). 

6.27 Date Tag Last Rpt (local) 

Report Unit:  Day of the Week 

The Date tag last rpt (local) field displays the day of the week part of the time tag of the last vessel 

report for a given day.  During processing, AISSource assigns a Coordinated Universal Time (UTC) 

formatted time tag to each message received.  AISMiner converts this UTC value to local (host) 

machine time before displaying the date part in the Date tag last rpt (local) field.  A new day begins 

at midnight local time.  This field is updated when a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is 

processed. 

Note:  See also Time tag last rpt (local). 

6.28 Day  

Report Unit:  Number 

The Day field displays the UTC day value from a report.  It is read from messages 4 and 11.  A base 

station periodically transmits message 4.  A mobile station transmits message 11 only in response to 

interrogation by a message 10.  The format for the Day field is 1-31, with 0 used when UTC day 

information is not available in the report. 

6.29 Destination  

Report Unit:  Text 
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The Destination field displays the name of a vessels next immediate port location.  This field is 

updated when a message type 5 is processed. 

6.30 Destination ID  

Report Unit:  Number 

Message types 6 and 12 are addressed message types, and are sent to specific destination stations.  

Message types 7 and 13 are acknowledgement messages to the addressed message types 6 and 12.  

The fields labeled Destination ID, Destination ID 1, Destination ID 2, Destination ID 3, and 

Destination ID 4 are used in this message interchange.  The Destination ID field is used by message 

type 6 and 12, and contains the MMSI number of the destination station.  Message types 7 and 13 

use the fields Destination ID 1, Destination ID 2, Destination ID 3, and Destination ID 4.  The 

acknowledgement message types 7 and 13 contain the same MMSI number listed in the sending 

stations Destination ID field.  Note that for message types 25 and 26 this field may be blank 

depending on the Destination Indicator field value.  If the Destination Indicator field value is zero 

(0), the Destination ID field will be blank.   

Note:  For a more comprehensive description, see NMEA 0183 v4.0. 

6.31 Destination ID 1  

Report Unit:  Number 

See Destination ID field description. 

6.32 Destination ID 2 

Report Unit:  Number 

See Destination ID field description. 

6.33 Destination ID 3 

Report Unit:  Number 

See Destination ID field description. 

6.34 Destination ID 4 

Report Unit:  Number 

See Destination ID field description. 

6.35 Destination ID A 

Report Unit:  Number 

The Destination ID A field displays the MMSI number of a destination (target) receiver.  Receivers 

which also transmit, such as those aboard vessels, are assigned MMSI numbers.  This value is part of 

message 16.  Message type 16 is transmitted by a base station, to target receiver(s), when it is 

operating as a controlling agent. 
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6.36 Destination Indicator 

Report Unit:  Number (1 or 0) 

Applicable to messages 25 and 26, the Destination Indicator field indicates whether or not there will 

be a value in the Destination ID field.  

6.37 Dimension (A, B, C, and D) 

Report Unit:  Meters 

The Meters field displays the dimensions of a ship.  A ship’s dimensions are reported in message 5.  

For class B vessels, the dimensions are reported in messages 19 and 24 part B.  The following figure 

shows how a ship’s dimensions are measured. 

Distance is in meters 

A & B = 0 – 511m 

C & D = 0 – 63m, 63 if > 63m 

   

Figure 65.  AIS – reference point dimensions. 

6.38 Draught  

Report Unit:  Meters 

The draught of a vessel is measured as the vertical distance between the waterline and the keel.  

Draught is measured in 1/10 meter increments from 0 to 25.5 meters.  The Draught field is updated 

when a message 5 is processed. 

6.39 Elapsed Time Since Last Pos Rpt 

Report Unit:  HH:MM:SS 

The Elapsed time since last pos rpt field displays the length of time elapsed since the last position 

report from a contact.  This field is updated when a message with position information is processed. 

6.40 ETA  

Report Unit:  Month/Day @ Time (UTC) 

The time which a vessel is expected to arrive at a destination location is referred to as Estimated 

Time of Arrival (ETA).  ETA is displayed in UTC time as month, day, hours, and minutes. The 

format for the displayed time is MM/DD @ HH:MM.  The ETA field value is read from message 5. 
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6.41 Hour  

Report Unit:  0-24 

The Hour field displays the UTC hour value from a report.  It is read from messages 4 and 11.  A 

base station periodically transmits message 4.  A mobile station transmits message 11 only in 

response to interrogation by a message 10.  The format for Hour is 0-23, with 24 used when UTC 

hour information is not available in the report.   

6.42 IMO #  

Report Unit:  Number 

The IMO # field displays the contacts (vessels) IMO number assigned by the International Maritime 

Organization. 

6.43 Keep Flag 

Report unit:  Number (0 or 1) 

The Keep flag field displays the state of the Keep Flag parameter, specified in the ITDMA 

communications state (see ITU-R M.1371-3, section 3.3.7.3.2).  This field is part of VDM messages 

3 and 18.  This field is set to (1) when True and (0) when False. 

6.44 Last Report Channel  

Report Unit:  Number 

The Last report channel field displays the channel designation (A or B) that a ship used for message 

transmission.  

6.45 Last Report Timetag (Age) 

Report Unit: Number 

The Last Report Timetag (Age) field displays the difference in seconds between a message time tag 

and the current time on the local machine.  This field dynamically updates as time passes. 

6.46 Last Report Timetag (Arrival Delta) 

Report Unit: Number 

The Last Report Timetag (Arrival Delta) field displays the difference in seconds between a message 

time tag and the time on the local machine when the message was received by AISMiner.  This field 

remains static as time passes.   

6.47 Last Rpt UTC (secs)  

Report Unit:  Number 

The Last Rpt UTC (secs) field displays the total number of seconds that have elapsed since the last 

vessel report.  The value in calculated using the minutes and hours of a message’s UTC time.  The 
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time is displayed in seconds to the whole minute past midnight.  This field information is read from 

the data portion of the SOTDMA message packet when the Slot Time Out equals 1.  This field value 

is updated when the Slot Time Out for messages 1, 2, 3, 4, 9, 11, or 18 equals 1. 

6.48 Last VDM type  

Report Unit:  Number 

The Last VDM type field displays the ID parameter from the most recently processed VDM message 

for a contact. 

6.49 Latitude  

Report Unit:  Deg 

The Latitude field displays the latitude position, in decimal degrees, of a contact at time of message 

transmission.  Messages 1, 2, 3, 4, 11, 17, 18, and 19 contain a contact’s latitude position.  The 

Latitude field is updated each time AISMiner processes a message containing Latitude.   

6.50 Latitude (degs) 

Report Unit:  Deg 

The Latitude (degs) field displays the latitude position, in decimal degrees, of a contact at time of 

message transmission.  Messages 1, 2, 3, 4, 11, 17, 18, and 19 contain a contact’s latitude position.  

The Latitude (degs) field is specific to each VDM message type, and is updated only upon receipt of 

the specified message type. 

6.51 Latitude 1 

Report Unit:  Deg/Min/Sec 

Message 23 is transmitted by a base station to command VHF Data Link (VDL) parameters (rules) 

for a geographical area defined in the message.  It provides notification to vessels within the defined 

area of VDL “rules” applying to vessel broadcasts.  The Latitude 1 parameter of message 23 

contains the upper right corner (north-east) of the defined area.  The parameters are +/- 90 degrees, 

North = positive, South = negative. 

6.52 Latitude 2 

Report Unit:  Deg/Min/Sec 

Message 22 is transmitted by a base station to command VHF Data Link (VDL) parameters (rules) 

for a geographical area defined in the message.  It provides notification to vessels within the defined 

area of VDL “rules” applying to vessel broadcasts.  The Latitude 2 parameter of message 22 

contains the upper right corner (south-west) of the defined area.  The parameters are +/- 90 degrees, 

North = positive, South = negative. 

6.53 Length  

Report Unit:  Meters 
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The overall distance of a vessel from back to front is its length.  The Length field is displayed in 1 

meter increments.  The field is updated when a message 5, 19, and 24 (part B) is processed. 

6.54 Line # First Pos  

Report Unit:  Number 

The Line # first pos field displays the line number in the log file of the first position report from a 

contact.  When AISMiner is in live data mode this field displays zero (0). 

6.55 Line # First Valid Pos  

Report Unit:  Number 

The Line # first valid pos field displays the line number in the log file of the first position report 

from a contact.  A valid position report contains course over ground, speed over ground, latitude and 

longitude information.  When AISMiner is in live data mode this field displays zero (0). 

6.56 Line # Max Range  

Report Unit:  Number 

The Line # max range field displays the line number in the log file of the maximum contact 

reception distance.  When AISMiner is in live data mode, or reception distance cannot be calculated, 

this field displays zero (0). 

6.57 Local OS Clock (UTC) 

Report Unit:  Seconds 

The Local OS Clock (UTC) field displays the number of seconds elapsed since midnight GMT.  The 

counter resets to zero each new day.  A new day starts at midnight local machine time. 

6.58 Longitude  

Report Unit:  Deg/Min/Sec 

The Longitude field displays the longitude position, in decimal degrees, of a contact at time of 

message transmission.  Messages 1, 2, 3, 4, 11, 17, 18, and 19 contain a contact’s longitude position.  

The Longitude field is updated each time AISMiner processes a message containing longitude 

information.   

6.59 Longitude (degs) 

Report Unit:  Deg 

The Longitude (degs) field displays the longitude position, in decimal degrees, of a contact at time of 

message transmission.  Messages 1, 2, 3, 4, 11, 17, 18, and 19 contain a contact’s longitude position.  

The Longitude (degs) field is specific to each VDM message type, and is updated only upon receipt 

of the specified message type. 
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6.60 Longitude 1 

Report Unit:  Deg/Min/Sec 

Message 23 is transmitted by a base station to command VHF Data Link (VDL) parameters (rules) 

for a geographical area defined in the message.  It provides notification to vessels within the defined 

area of VDL “rules” applying to vessel broadcasts.  The Longitude 1 parameter of message 23 

contains the upper right corner (north-east) of the defined area.  The parameters are +/- 180 degrees, 

East = positive, West = negative. 

6.61 Longitude 2 

Report Unit:  Deg/Min/Sec 

Message 22 is transmitted by a base station to command VHF Data Link (VDL) parameters (rules) 

for a geographical area defined in the message.  It provides notification to vessels within the defined 

area of VDL “rules” applying to vessel broadcasts.  The Longitude 2 parameter of message 22 

contains the upper right corner (south-west) of the defined area.  The parameters are +/- 180 degrees, 

East = positive, West = negative. 

6.62 Minute  

Report Unit:  Number 

The Minute field displays the UTC Minute value of a report.  It is read from messages 4 and 11.   A 

base station periodically transmits message 4.  A mobile station transmits message 11 only in 

response to interrogation by a message 10.  The format for Minute is 0-59; a value of 60 is shown 

when UTC minute information is not available in the report. 

6.63 Month  

Report Unit:  Number 

The Month field displays the UTC Month value of a report.  It is read from messages 4 and 11.  A 

base station periodically transmits message 4.  A mobile station transmits message 11 only in 

response to interrogation by a message 10.  The format for Month is 1-12; a value of 0 is shown 

when UTC minute information is not available in the report. 

6.64 Name  

Report Unit:  Text 

The Name field displays the name of a contact transmitting an AIS message.  The contact name may 

be read from an AIS message or retrieved from the VesselList.txt file.  A name, displayed in the 

table view, followed by three asterisk symbols indicates that it was read from the VesselList.txt file.  

A name displayed not followed by three asterisk symbols indicates that it was read from a message 5 

or 19.  If the first message of the day from a contact is not a message 5 or 19 and the name is not in 

the VesselList.txt file, AISMiner will display the vessels MMSI number in the Name field followed 

by three asterisk symbols.  Once a contact’s message 5 or 19 is processed the vessel’s MMSI 

number, or retrieved name, is replaced in the table view with the contact’s name from the message. 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  80 

6.65 Nav Solution Date (GMT)   

Report Unit:  Week Day, DayMonthYear 

AISSource attaches a time tag to all messages.  The time tag is formatted to UTC; which is seconds 

elapsed since midnight, January 1, 1970 GMT.  To correct for receiver time “drift”, during 

processing AISMiner adjusts the message time tag.  The Nav solution date (GMT) field displays the 

adjusted time, formatted as the day of the week, day, month, and year of message broadcast (e.g., 

Tuesday 19Jan2010).  

6.66 Nav Solution Time (GMT)   

Report Unit:  hr:min:sec 

AISSource attaches a time tag to all messages.  The time tag is formatted to UTC; which is seconds 

elapsed since midnight, January 1, 1970 GMT.  To correct for receiver time “drift”, during 

processing AISMiner adjusts the message time tag.  The Nav solution time (GMT) field displays the 

adjusted time, formatted as the time of the day of the Nav solution time (e.g., 01:04:57). 

6.67 Nav Solution Time (UTC)   

Report Unit:  Seconds  

The Nav Solution Time (UTC) field displays the vessels Navigation Solution Time of a position 

report in seconds since midnight, January 1, 1970 GMT.  This field is updated when a position report 

message is processed. 

6.68 Nav Status  

Report Unit:  Text 

The Nav Status field displays the following contact navigational information: whether the contact is 

underway using engines or sails; moored; anchored or run aground; and, when the contact is limited 

in its ability to maneuver.  This field is updated when a message 1, 2, or 3 is processed. 

6.69 Number of Slots 

Report Unit:  Number 

The Number of slots field displays the number of VDL slots occupied by the [contact] message. 

6.70 Offset 1  

Report Unit:  Number 

The Offset 1 field displays the offset (difference) from the slot number that a message 20 was 

received on to the first slot number reserved. 

6.71 Part Number  

Report Unit:  0 or 1 
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The Part number field displays which part of message 24 is being processed.  Message 24 is 

transmitted as two separate messages (Part A and Part B).  Part B is transmitted within 1 minute of 

Part A.  This field is formatted as follows: Part A = 0; and, Part B = 1.  Message 24 is used by Class 

B shipborne mobile equipment. 

6.72 Pos Accuracy  

Report Unit:  0 or 1 

The Pos Accuracy field values are either 0 or 1.  1 = High accuracy (<10m; differential mode of e.g. 

DGNSS receiver).  0 = low accuracy (>10m; autonomous mode of e.g. global navigation satellite 

system (GNSS) receiver or of other electronic position fixing device). 

6.73 Pos Fix Type  

Report Unit:  Text 

Many vessels have multiple equipment sources supplying position information.  Each position fixing 

device’s output is an input to the AIS unit.  The Pos fix type field displays the type of device which 

supplied the position values of a broadcast message.  Global Positioning System (GPS), Global 

Navigation Satellite System (GLONASS), Loran-c, Chayka, and Integrated Navigation System are 

the types of electronic position fixing devices that could supply the position information.  This field 

is updated when a message 4, 5 or 21 is processed. 

6.74 Pos Report Period (secs)  

Report Unit:  Seconds 

The Pos report period (secs) field displays the time between the first position report received each 

day, by a contact, and the most current contact position report.  This field is updated each time a 

position report is received.   

6.75 Pos Report Rate (#/[pos rpt period/60])  

Report Unit:  Number 

The Pos report rate (#/[pos rpt period/60]) field displays the number of contact position reports 

received per minute.  The field value is determined by dividing # Pos rpts by Pos report period 

(secs) value.  This field is updated each time a contact position report is processed. 

6.76 # Pos Rpts  

Report Unit:  Number 

AISMiner keeps track of the number of position reports received and displays it in # Pos rpts field.  

The field value is the cumulative total of messages 1, 2, 3, 4, 9, 11, 18, 19, and 21 for a contact on a 

given receiver.  When a contact is received on multiple receivers, the # Pos rpts value is calculated 

independently for each receiver. 
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6.77 # Pos Rpts Valid 

Report Unit:  Number 

A valid position report is a position report that contains valid latitude, longitude, course over ground, 

and speed over ground.  Latitude is valid when it is greater than –90 and less than 90. Longitude is 

valid when it is greater than –180 and less than 180.  Course Over Ground must be between 0 and 

360 degrees and Speed Over Ground must be a positive value to be valid.  The # Pos rpts valid field 

value is the total number of valid position reports from messages 1, 2, 3, 9, 18, and 19. 

6.78 Power  

Report Unit:  0 or 1 

The Power field displays the power value from message 22.  Message 22 is used to command the 

VHF data link parameters for the geographical area designated in the message.  The format for 

Power is: 0 = high (default), 1 = low. 

6.79 Quiet Time   

Report Unit:  Number (0 – 15) 

The Quiet time field displays the length of time elapsed between transmission of a message 18 or 24 

by a Class B station.  This is in response to a message 22 command.  Field values are: 0 (default - no 

quiet time commanded); and, 1 – 15 (quiet time of 1 to 15 minutes). 

6.80 RAIM Flag  

Report Unit:  0 or 1 

The RAIM flag field displays the RAIM (Receiver Autonomous Integrity Monitoring) flag value of 

an electronic position fixing device.  Acceptable values are formatted as follows; 0 = RAIM not in 

use (default); and, 1 = RAIM in use.  

6.81 Range  

Report Unit:  Nautical Miles 

The Range field displays the distance in NM between a contact’s message broadcast and the 

receiver’s location.  AISMiner stores the latitude and longitude location of receivers in the 

Baseinfo.txt file.  When the receiver’s position is known, AISMiner uses this information to 

calculate the current distance of each new contact message.  

Note:  AISMiner is unable to accurately calculate distances when the land based receiver site and the 

contact are in different hemispheres and the closest E/W transition is at 180 degrees. 

6.82 Range - Cumulative  

Report Unit:  Nautical Miles 
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The Range – cumulative field displays a summation of all calculated range values, over a period of 

time, from a receiver/vessel pairing in a processed dataset.  This field is updated with each new 

message. 

6.83 Range - First  

Report Unit:  Nautical Miles 

The Range – first field displays the distance in NM between a contact’s first message broadcast and 

the receiver’s location.  AISMiner stores the latitude and longitude location of receivers in the 

Baseinfo.txt file.  When the receiver’s position is known, AISMiner uses this information to 

calculate the distance of the first contact message in a processed dataset.  

Note:  All distance calculations are planar and are rounded up. 

6.84 Range - Maximum  

Report Unit:  Nautical Miles 

The Range – maximum field displays the maximum distance in NM between a contact’s message 

broadcasts and a receiver’s location.  The maximum distance is calculated by comparing the value in 

Range field to the value in Range - maximum field each time a new contact distance value is 

calculated.  When the value in the Range field is greater than the value in the Range - maximum field 

the value in Range - maximum field is updated. 

6.85 Range - Minimum  

Report Unit:  Nautical Miles 

The Range – minimum field displays the minimum distance in NM between a contact’s message 

broadcasts and a receiver’s location.  The minimum distance is calculated by comparing the value in 

Range field to the value in Range - minimum field each time a new contact distance value is 

calculated.  When the value in the Range field is greater than the value in the Range - minimum field 

the value in Range - minimum field is updated. 

6.86 RCVR # Blocks Lost  

Report Unit:  Number 

The RCVR # blocks lost field displays the number of blocks of messages lost by a receiver over a 

period of time.  A block consists of one or more messages.  Some receivers insert index numbers 

into their messages.  By counting the index numbers, AISMiner can determine if messages have 

been lost.       

6.87 Rcvr Cumulative Lines Lost 

Report Unit:  Number 

The Rcvr cumulative lines lost field displays the number of lines of data lost from a receiver over a 

period of time.  Note that a message can consist of more than one line of data.   
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6.88 RCVR # Lines Lost Total 

Report Unit:  Number 

The RCVR # lines lost total field displays the same information as the Rcvr cumulative lines lost 

field described above.   

Note:  The RCVR # lines lost total field will be removed from the next version of AISMiner.   

6.89 Rcvr ID   

Report Unit:  Text 

The Rcvr ID field displays the unique identification value of a receiver.  Land based receiver sites 

use AISSource software to process and retransmit AIS messages.  Each receiver at a site is 

connected to the site controller computer, running AISSource, through a serial port connection.  

Each serial port has a unique identifier number assigned to it, in the AISSource.ini file, by the 

AISSource administrator.  The unique identifier number serves as the identification number for the 

receiver attached to that port, and is referred to as the Receiver ID.  The Receiver ID number is 

appended to each AIS message received on that port.   

6.90 Rcvr Largest Lost Block 

Report Unit:  Number 

The RCVR largest lost block field displays the highest number of lines lost in a single block by a 

receiver.  Some receivers insert index numbers into their messages.  By counting the index numbers, 

AISMiner can determine if messages have been lost.  A block consists of one or more messages. 

6.91 Rcvr Last Index   

Report Unit:  Number 

The Rcvr last index field displays the index number of the last message sent by a receiver to 

AISSource which was not lost.  Some receivers insert index numbers to their messages.  By counting 

the index numbers, AISMiner can determine if messages have been lost.   

6.92 Rcvr Last Lost Block End Time   

Report Unit:  hr:mm:ss 

The Rcvr last lost block end time field displays the end [transmission] time of the last block of lost 

messages.  Some receivers insert index numbers into their messages.  By counting the index 

numbers, AISMiner can determine if messages have been lost.  A block consists of one or more 

messages. 

For example, a message received at 13:40:00 with an index number of (100) followed by another 

message received at 13:45:00 with an index number of (109) would show a value of 13:45:00 in this 

field.   
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6.93 Rcvr Last Lost Block Size   

Report Unit:  Number 

The Rcvr last lost block size field displays the number of lines lost from the last block of messages.  

Some receivers insert index numbers into their messages. By counting the index numbers, AISMiner 

can determine if messages have been lost.  A block consists of one or more messages. 

6.94 Rcvr Last Lost Block Start Time   

Report Unit:  hr:mm:ss 

The Rcvr last lost block start time field displays the start (transmission) time of the last block of lost 

messages.  Some receivers insert index numbers into their messages. By counting the index 

numbers, AISMiner can determine if messages have been lost.  A block consists of one or more 

messages. 

For example, a message received at 13:40:00 with an index number of (100) followed by a message 

received at 13:45:00 with an index number of (109) would show a value of 13:40:00 in this field.   

6.95 Rcvr Pct Lost  

Report Unit:  Percentage 

The Rcvr pct lost field displays the percentage of lost messages over a period of time.  Some 

receivers insert index numbers into their messages.  By counting the index numbers, AISMiner can 

determine if messages have been lost.  .   

For example, if AISMiner receives (1000) messages over the period of a day and, through index 

counting, shows a loss of (100) messages, this field will display a value of 10%.   

6.96 RCVR Total Expected Line Count 

Report Unit:  Number 

The RCVR Total expected line count field displays the total number of lines of message data 

expected over a period of time.  Some receivers insert index numbers into their messages.  By 

counting the index numbers, AISMiner can determine if messages have been lost. A message 

consists of one or more lines.   

For example, if at 12:00:00 AISMiner receives a message with an index count of 100 and at the end 

of that day 11:59:59 AISMiner receives a message with an index count of 1000, this field will 

display a value of 900. 

6.97 Rcvr Total Line Count   

Report Unit:  Number 

The Rcvr Total line count field displays the total number of message lines received.  Some receivers 

insert index numbers into their messages.  By counting the index numbers, AISMiner can determine 

if message lines have been lost.  A message consists of one or more lines. 
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6.98 Rcvr UTC Error  

Report Unit:  Seconds 

The Rcvr UTC error field displays the difference between time of message transmission and the time 

stamp attached by AISSource.  This value is calculated using time information contained within 

messages 1, 2, 4, 9, 11, and 18.  This field is updated when the Slot Timeout value for a message 1, 

2, 4, 9, 11, or 18 is (1). 

6.99 Received Stations 

Report Unit:  Number 

The Received stations field displays the number of stations being received by the transmitting 

station. 

6.100 Reference Altitude  

Report Unit:  Meters 

The Reference Altitude field is used when a receiver site is aboard an airplane.  The altitude of the 

receiver site measured in meters above mean sea level is displayed in this field.  The altitude value is 

read from the onboard GPS unit.  The format is: 0-4094 m, 4095 (not available). 

6.101 Reference COG   

Report Unit:  1/10 increments ( 0 < 360) 

The Reference COG field displays the Course Over Ground (COG) direction a mobile receiver site is 

traveling across the earth’s surface.  This field information is read from the site’s GPS unit.  

6.102  Reference SOG   

Report Unit:  Knots 

The Reference SOG field displays the Speed Over Ground (SOG) a mobile receiver site is traveling 

across the earth’s surface.  This field information is read from the site’s GPS unit.  

6.103  Repeat Indicator  

Report Unit:  Number 

The Repeat indicator field displays the number of times a message has been repeated.  This value is 

contained within every AIS message. 

6.104  Report Period  

Report Unit:  Seconds 

The Report period field displays the time difference in seconds between the first report received 

each day and the most current report.  This field is updated each time a new report is processed. 
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6.105  Report Period (secs)  

Report Unit:  Seconds 

The Report period (secs) field displays the time difference in seconds between the first message 4 

report received each day and the most current message 4 report.  This field is updated each time a 

new message 4 report is processed. 

6.106  Report Rate  

Report Unit:  Number 

The Report rate field displays the number of reports received per minute over a report period.  The 

field value is calculated by dividing the total number of reports processed by the report period.  This 

field is updated each time a new message is processed. 

6.107  Report Rate A  

Report Unit:  Reports/Minute 

The Report rate A field displays the number of reports, transmitted on Channel A, received per 

minute over a report period.  The field value is calculated by dividing the total number of reports, 

transmitted on Channel A, processed by the report period.  This field is updated each time a new 

message, transmitted on Channel A, is processed. 

6.108  Report Rate B  

Report Unit:  Reports/Minute 

The Report rate B field displays the number of reports, transmitted on Channel B, received per 

minute over a report period.  The field value is calculated by dividing the total number of reports, 

transmitted on Channel B, processed by the report period.  This field is updated each time a new 

message, transmitted on Channel B, is processed. 

6.109  Reporting Interval  

Report Unit:  Number (0 – 15) 

The Reporting interval field displays the report rate, assigned by a base station operator and, 

commanded by a message 23 broadcast.  A base station operator can define a geographic area and 

command AIS units, on vessels navigating within this defined area, to report messages at rates 

different than those built into these units.   

6.110 # Reports 

Report Unit:  Number 

Count of reports received over a period of time. 

6.111 # Reports A  

Report Unit:  Number 
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Total of all messages transmitted on Channel A from a contact.  When the channel in the VDM 

statement is Channel A, the # reports A field is incremented by one.  

6.112 # Reports B 

Report Unit:  Number 

The # reports B field is the total of all messages transmitted on Channel B from a contact.  When the 

channel in the VDM statement is Channel B, the # reports B field value is incremented by one. 

6.113 # Rpts Total 

Report Unit:  Number 

The # rpts total field displays the total number of messages received over a period of time. 

6.114 Retransmit Flag  

Report Unit:  0 or 1 

The Retransmit flag field displays whether or not a message has been retransmitted.  The field values 

are: 0 = not retransmitted (default); 1 = retransmitted. 

6.115  ROT  

Report Unit:  Degrees per Minute 

The ROT field displays a vessel’s Rate Of Turn (ROT), which is how fast a contact is changing 

course.  ROT is reported as the number of degrees per minute from 0 to 720.  When the rate of turn 

is more that 720 per minute, it is indicated as greater than 720.  When the rate of turn is negative, 

the contact is turning to its port.  When it is positive, the contact is turning to its starboard.  The ROT 

field is updated when a message 1, 2, or 3 is processed. 

6.116  RSSI Level A  

Report Unit:  Number 

The RSSI Level A field displays receiver signal strength of messages transmitted on Channel A.  

Signal strength is added to all messages when received by a receiver which provides signal strength 

information.  The RSSI Level A field of an AIS message is populated with signal strength when the 

message is transmitted on Channel A.  Because signal strength measurement is not consistent 

between receiver manufacturers, this value must be converted manually.  The value from the RSSI 

Level A field of an AIS message is converted by AISMiner to decibels using the manufacturer’s 

calibration curve. 

6.117  RSSI Level B  

Report Unit:  Number 

The RSSI Level B field displays receiver signal strength of messages transmitted on Channel B.  

Signal strength is added to all messages when received by a receiver which provides signal strength 
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information.  The RSSI Level B field of an AIS message is populated with signal strength when the 

message is transmitted on Channel B.  Because signal strength measurement is not consistent 

between receiver manufacturers, this value must be converted manually.  The value from the RSSI 

Level B field of an AIS message is converted by AISMiner to decibels using the manufacturer’s 

calibration curve. 

6.118  (S_M) Cumulative dBm 

Report Unit:  dBm 

Shine Micro receiver information.  

6.119 (S_M) Signal Level in dBm  

Report Unit:  dBm 

Shine Micro receiver information.  Shine Micro receiver appends a signal report to each VDM 

sentence. 

6.120 (S_M) Slot Number 

Report Unit:  Number 

Shine Micro receiver information.  Shine Micro receiver appends the slot number to the end of each 

VDM sentence. 

6.121 (S_M) Timestamp 

Report Unit:  Number 

Shine Micro receiver information.  Shine Micro receiver appends a timestamp to each VDM 

sentence. 

6.122 (S_M) TOA UTC 

Report Unit:  Number 

Shine Micro receiver information.  Time Of Arrival report in seconds from UTC zero (0). 

6.123 (S_M) Total # dBm Reports 

Report Unit:  Number 

Shine Micro receiver information.  Count of (S_M) Signal level in dBm reports received. 

6.124  Second  

Report Unit:  Number 

The Second field displays the UTC Second value of a report.  It is read from messages 4 and 11.   A 

base station periodically transmits message 4.  A mobile station transmits message 11 only in 
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response to interrogation by a message 10.  The format for Second is 0-59, with 60 used when UTC 

second information is not available in the report. 

6.125  Sequence #  

Report Unit:  Number (0-3) 

Message types 6 and 12 are addressed message types, and are sent to specific destination stations.  

Message types 7 and 13 are acknowledgement messages to the addressed message types 6 and 12.  

The acknowledgement message fields labeled Sequence #, Sequence #1, Sequence #2, Sequence #3, 

and Sequence #4 are used in this message interchange to acknowledge receipt of an addressed 

message.  The Sequence # field displays the Sequence number field value from the 

acknowledgement message.  

Note:  For a complete description, see ITU-R M.1371-3 5.3.1 Annex 2. 

6.126 Sequence #1 

Report Unit:  Number 

See Sequence # field description. 

6.127  Sequence #2 

Report Unit:  Number 

See Sequence # field description. 

6.128  Sequence #3 

Report Unit:  Number 

See Sequence # field description. 

6.129  Sequence #4 

Report Unit:  Number 

See Sequence # field description. 

6.130  Ship Type  

Report Unit:  Text 

The Ship type field displays the contact vessel type description reported in messages 5 and 19.  

Possible values include: cargo; tanker; and, passenger.    

6.131 Slot Increment 

Report Unit:  Number 
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The Slot increment field displays the offset to the next slot to be used, or zero (0) if no further 

transmission, for messages containing an ITDMA communication state.    

Note:  For a complete description, see ITU-R M.1371-3 3.3.7.3.2 Annex 2. 

6.132 Slot Number 

Report Unit:  Number 

The Slot number field displays the slot number used for this transmission.  This applies to messages 

containing an SOTDMA communication state when the Slot Timeout is 2, 4, or 6. 

Note:  For a complete description, see ITU-R M.1371-3 3.3.7.2.3 Annex 2. 

6.133 Slot Offset 

Report Unit: Number 

The Slot offset field displays the offset to the slot in which transmission will occur during the next 

VDL frame.  This applies to messages containing an SOTDMA communication state when the Slot 

Timeout is zero (0).  

Note:  For a complete description, see ITU-R M.1371-3 3.3.7.2.3 Annex 2. 

6.134 Slot Timeout 

Report Unit: Number 

The Slot timeout field displays the number of frames remaining until a new slot is selected.  This 

applies to messages containing an SOTDMA communication state.  

Note:  For a complete description, see ITU-R M.1371-3 3.3.7.2.2 Annex 2. 

6.135  SOG  

Report Unit:  Knots 

Speed Over Ground (SOG) is a measurement of the speed a contact is traveling over the earth’s 

surface.  The SOG field is reported in 1/10 knot increments, from 0 to 102.2.  When a contact is 

traveling faster than 102.2 knots it is reported as 102.2 knots.  The SOG field is updated when a 

message 1, 2, 3, 18, or 19 is processed. 

6.136  SOG (kt)  

Report Unit:  Knots 

Speed Over Ground (SOG) is a measurement of the speed a contact is traveling over the earth’s 

surface.  The SOG (kt) field is reported in 1/10 knot increments, from 0 to 102.2.  When a contact is 

traveling faster than 102.2 knots it is reported as 102.2 knots.  The SOG (kt) field is updated when a 

message 1, 2, 3, 18, or 19 is processed. 
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6.137  Station Type  

Report Unit:  Number 

The Station Type field displays the station designation number reported in message type 23.  

Designation numbers are: 0 = all types of mobiles; 1 = reserved for future use; 2 = all types of Class 

B mobile stations; 3 = SAR airborne mobile stations; 4 = AtoN station; 5 = Class B”CS” shipborne 

mobile station; 6 = inland waterways; 7 to 9 = regional use; and, 10 to 15 = reserved for future use. 

6.138 Sync State 

Report Unit:  Number 

The Sync state field displays a number corresponding to the type of time synchronization used by the 

transmitting station.  This field is updated when a message containing a SOTDMA communication 

state is processed. 

Note:  For a complete description, see ITU-R M.1371-3 3.3.7.2.2 Annex 2. 

6.139  Text  

Report Unit:  Text 

Message type 14 is used for broadcasting safety related information.  The Text field displays the 

safety related information within this message.  This field is updated when a message type 14 is 

processed.  

6.140 Timestamp 

Report Unit:  Number 

The Timestamp field displays the UTC second when the report was generated by the vessels 

electronic position system.  0-59 = time value, 60 = not available, 61 = positioning system in manual 

input mode, 62 = electronic position system operating in dead reckoning mode, 63 = positioning 

system inoperative. 

6.141  Time Tag First Rpt (GMT)   

Report Unit:  hr:min:sec 

The Time tag first rpt (GMT) field displays the time part of the time tag of the first vessel report for a 

given day.  During processing, AISSource assigns a UTC formatted time tag to each message 

received.  AISMiner converts this UTC value to GMT before displaying the time part in the Time tag 

first rpt (GMT) field.  A new day begins at midnight local machine time. This field is updated when 

a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is processed. 

Note:  See also Date tag first rpt (GMT). 

6.142  Time Tag First Rpt (local) 

Report Unit:  hr:min:sec 
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The Time tag first rpt (local) field displays the time part of the time tag of the first vessel report for a 

given day.  During processing, AISSource assigns a UTC formatted time tag to each message 

received.  AISMiner converts this UTC value to local (host) machine time before displaying the time 

part in the Time tag first rpt (local) field.  A new day begins at midnight local machine time.  This 

field is updated when a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is processed. 

Note:  See also Date tag first rpt (local). 

6.143  Time Tag Last Rpt (GMT)  

Report Unit:  hr:min:sec 

The Time tag last rpt (GMT) field displays the time part of the time tag of the last vessel report for a 

given day.  During processing, AISSource assigns a UTC formatted time tag to each message 

received.  AISMiner converts this UTC value to GMT before displaying the time part in the Time tag 

last rpt (GMT) field.  A new day begins at midnight local machine time.  This field is updated when 

a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is processed. 

Note:  See also Date tag last rpt (GMT). 

6.144  Time Tag Last Rpt (local) 

Report Unit:  hr:min:sec 

The Time tag last rpt (local) field displays the time part of the time tag of the last vessel report for a 

given day.  During processing, AISSource assigns a UTC formatted time tag to each message 

received.  AISMiner converts this UTC value to local (host) machine time before displaying the time 

part in the Time tag last rpt (local) field.  A new day begins at midnight local machine time.  This 

field is updated when a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 is processed. 

Note:  See also Date tag last rpt (local). 

6.145  Time Tag Last Rpt (UTC) 

Report Unit:  hr:min:sec 

The Time tag last rpt (UTC) field displays the time part of the time tag of the last vessel report for a 

given day.  During processing, AISSource assigns a UTC formatted time tag to each message 

received.  AISMiner displays this UTC value in the Time tag last rpt (UTC) field.  A new day begins 

at midnight local machine time.  This field is updated when a message 1, 2, 3, 4, 9, 11, 18, 19, or 21 

is processed. 

Note:  A value of 60 = not available, 61 = positioning system in manual input mode, 62 = electronic 

position system operating in dead reckoning mode, 63 = positioning system inoperative. 

6.146  Transitional Zone Size  

Report Unit:  Nautical Miles 
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The Transitional zone size field displays the size of a transition zone.  A transition zone is defined 

as: a zone where a vessel goes from one broadcast region to the next.  This field is updated when a 

message type 22 is processed. 

6.147  True Heading  

Report Unit:  Integer ( 0 < 360) 

The True Heading field displays the compass direction of a vessel (contact).  In figure 66 below the 

vessel Heading is 240, but because of wind or ocean currents pushing at it, it’s actual forward 

direction (COG) is 260.  This field is updated when a message 1, 2, 3, 18, or 19 is processed.  The 

Heading value is reported in 1 increments, from 0 to 359.   

 

Figure 66.  Heading and course over ground example. 

6.148 Tx Mode  

Report Unit:  Number (0 – 3) 

The Tx mode field displays the Transmit mode designation value from message type 23.   

6.149  Tx/Rx Mode  

Report Unit:  Number (0 – 3) 

The Tx/Rx Mode field displays the Transmit/Receive mode designation value from message type 22. 

6.150 UTC Hour/Minute 

Report Unit:  hh:mm 

The UTC hour/minute field displays the UTC hour/minute value contained within the SOTDMA 

communication state where the Slot Timeout is (1). 
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Note:  For a complete description, see ITU-R M.1371-3 3.3.7.2.3 Annex 2. 

6.151 UTC Hour/Minute (CS) 

Report Unit:  hh:mm 

The UTC hr/min (CS) field displays the UTC hour/minute value contained within message types 4 

and 11.  

6.152  Vendor ID  

Report Unit:  Text 

The Vendor ID field displays the AIS unit’s unique identification assigned by the unit’s 

manufacturer.  This field is updated when a message type 24 is processed. 

6.153  Vessel ID   

Report Unit:  Number  

The Vessel ID field displays a vessel’s MMSI number.      

6.154  Year  

Report Unit:  Year 

The Year field displays the UTC Year value of a report.  It is read from messages 4 and 11.  A base 

station periodically transmits message 4.  A mobile station transmits message 11 only in response to 

interrogation by a message 10.  The format for Year is 1-9999, with 0 used when UTC year 

information is not available in the report. 
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7 RECEIVER VIEW WINDOW - TABLE VIEW 

Following is a list of fields, in alphabetical order, and their associated definitions, viewable in the 

table view of the AISMiner Receiver View window.   

Note:  See section 5.3.3 for information on how to customize the table view of the Receiver View 

window. 

Important:  For fields displaying values calculated over a period of time, in live data mode the 

period of time consists of one day beginning at midnight local machine time.  In saved data mode, 

the period of time spans the length of the dataset. 

7.1 FSR Count 

Report Unit:  Number 

The FSR Count field displays the total number of Frame Summary Report (FSR) messages received, 

per receiver, over a period of time. 

7.2 FSR Count A 

Report Unit:  Number 

The FSR Count A field displays the total number of Channel A FSR messages, received per receiver, 

over a period of time. 

7.3 FSR Count B 

Report Unit:  Number 

The FSR Count B field displays the total number of Channel B FSR messages, received per receiver, 

over a period of time. 

7.4 FSR CRC Failures A 

Report Unit:  Number 

The FSR CRC Failures A field displays the total number of Cyclic Redundancy Check (CRC) 

failures reported for Channel A, per receiver, over a period of time. 

7.5 FSR CRC Failures B 

Report Unit:  Number 

The FSR CRC Failures B field displays the total number of CRC failures reported for Channel B, per 

receiver, over a period of time. 

7.6 FSR High Noise A 

Report Unit:  Number 
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The FSR High Noise A field displays the highest reported noise level for Channel A, per receiver, 

over a period of time. 

7.7 FSR High Noise B 

Report Unit:  Number 

The FSR High Noise B field displays the highest reported noise level for Channel B, per receiver, 

over a period of time. 

7.8 FSR Low Noise A 

Report Unit:  Number 

The FSR Low Noise A field displays the lowest reported noise level for Channel A, per receiver, over 

a period of time. 

7.9 FSR Low Noise B 

Report Unit:  Number 

The FSR Low Noise B field displays the lowest reported noise level for Channel B, per receiver, over 

a period of time. 

7.10 FSR Noise A Delta 

Report Unit:  Number 

The FSR Noise A Delta field displays the difference between the highest and lowest reported noise 

level for Channel A, per receiver, over a period of time. 

7.11 FSR Noise B Delta 

Report Unit:  Number 

The FSR Noise B Delta field displays the difference between the highest and lowest reported noise 

level for Channel B, per receiver, over a period of time. 

7.12 FSR Noise Level A 

Report Unit:  Number 

The FSR Noise Level A field displays the last reported noise level for Channel A per receiver. 

7.13 FSR Noise Level B 

Report Unit:  Number 

The FSR Noise Level B field displays the last reported noise level for Channel B per receiver. 

7.14 FSR Report Time 

Report Unit:  hh:mm:ss 
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The FSR Report Time field displays the receipt time of the last FSR message per receiver. 

7.15 FSR Report Time A 

Report Unit:  hh:mm:ss 

The FSR Report Time A field displays the receipt time of the last FSR message for Channel A per 

receiver. 

7.16 FSR Report Time B 

Report Unit:  hh:mm:ss 

The FSR Report Time B field displays the receipt time of the last FSR message for Channel B per 

receiver. 

7.17 FSR Slots Occupied A 

Report Unit:  Number 

The FSR Slots Occupied A field displays the number of slots reported as being used by the last FSR 

for Channel A per receiver. 

7.18 FSR Slots Occupied B 

Report Unit:  Number 

The FSR Slots Occupied B field displays the number of slots reported as being used by the last FSR 

for Channel B per receiver. 

7.19 Rcvr ID 

Report Unit:  Text 

The Rcvr ID field displays the unique identification value of a receiver. 

7.20 Rcvr Last Lost Block Duration 

Report Unit:  hh:mm:ss 

The Rcvr Last Lost Block Duration field displays the elapsed time between receipt of two messages 

with non-sequential index numbers.  Some receivers insert index numbers into their messages.  By 

counting the index numbers, AISMiner can determine if messages have been lost.  A block consists 

of one or more messages.   

7.21 Rcvr Last Lost Block Start 

Report Unit:  hr:mm:ss 

The Rcvr Last Lost Block Start field displays the start (transmission) time of the last block of lost 

messages.  Some receivers insert index numbers into their messages.  By counting the index 
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numbers, AISMiner can determine if messages have been lost.  A block consists of one or more 

messages. 

For example, a message received at 13:40:00 with an index number of (100) followed by a message 

received at 13:45:00 with an index number of (109) would show a value of 13:40:00 in this field.   

7.22 Rcvr Lost Line % 

Report Unit:  Percentage 

The Rcvr Lost Line % field displays the percentage of lines of data lost, per receiver, over a period of 

time.  Some receivers insert index numbers into their messages.  By counting the index numbers, 

AISMiner can determine if lines of data have been lost.  A message consists of one or more lines.   

7.23 Rcvr Total Line Count 

Report Unit:  Number 

The Rcvr Total Line Count field displays the total number of message lines received, per receiver, 

over a period of time.  Some receivers insert index numbers into their messages.  By counting the 

index numbers, AISMiner can determine if message lines have been lost.  A message consists of one 

or more lines.   

7.24 Rcvr VDM Rpts A 

Report Unit:  Number 

The Rcvr VDM Rpts A field displays the total number of VDM messages received on Channel A, per 

receiver, over a period of time.   

7.25 Rcvr VDM Rpts B 

Report Unit:  Number 

The Rcvr VDM Rpts B field displays the total number of VDM messages received on Channel B, per 

receiver, over a period of time.   

7.26 Rcvr Lost Block Count 

Report Unit:  Number 

The RCVR Lost Block Count field displays the number of blocks of messages lost, per receiver, over 

a time period.  A block consists of one or more messages.  Some receivers insert index numbers into 

their messages.  By counting the index numbers, AISMiner can determine if messages have been 

lost.       

7.27 Shine 10 Count 

Report Unit:  Number 

The Shine 10 Count field displays the total number of proprietary Shine Micro Message 10 messages 

received, per receiver, over a period of time.   
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8 EXAMPLE DATA ANALYSIS 

AISMiner can be used to isolate and extract AIS data for many different types of analyses.  In the 

following example AISMiner and Microsoft Excel are used to calculate the maximum and mean 

contact distances for two receivers at the [R&DC] Fishers Island, NY site.  

1. Start AISMiner. 

2. To open the View Editor window, from the View menu item select Edit a View then click 

View #4. 

3. To populate the Selectable items list with fields not associated with a particular VDM 

sentence, click the General Info radio button (red outline – Figure 67). 

4.  Use the Add arrow button to add the following fields to the Items in current view list. 

• Vessel ID. 

• Receiver ID. 

• # Pos rpts valid. 

• Range – cumulative. 

• # Pos rpts. 

• Range – minimum. 

• Range. 

• Range – maximum. 

• Bearing. 

• SOG. 

• Range – first. 

• COG. 

• Latitude. 

• Longitude. 

• Nav solution time (GMT). 

• Nav solution date (GMT). 
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Figure 67.  AISMiner – view editor window. 

5. Click the Ok button to close the View Editor window and save the changes. 

6. From the View menu item, select View #4.  Note that the table view field names change to 

match the View Editor list. 

7. To open the Filters Editor window (Figure 68), from the Tools menu item select Edit Filters. 

8. On the Speed filter (orange outline - Figure 68), click the Allow Selected button and set 

Faster Than to .5 and Slower Than to 30. 

9. On the Range filter (green outline - Figure 68), click the Allow Selected button and set Near 

Limit to 0 and Far Limit to 250. 

10. On the Time (UTC) filter (purple outline - Figure 68), click the Allow Selected button and 

set the Start time to 6:00 and the End time to 12:00. 

11. On the Receivers filter (blue outline - Figure 68), click the Allow Selected button.  Using the 

Add button (red outline - Figure 68), add the following two Fishers Island, NY receivers to 

the Selected list, or any two receivers from a site of your choice.   

• r003669957. 

• r003669959. 
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Note:  If you have not already opened a saved log file using AISMiner, follow these steps to 

populate the Receivers section Known list:   

o From the File menu item select Open File.   

o Using the Open file window, navigate to and open a saved log file.  Log files are kept 

in the directory listed in the AISMiner.ini file setting LogDir (§ 4.1.1.10).       

o From the main interface, click the Resume button.   After a few seconds click the 

Stop button to stop data processing.    

 

Figure 68.  AISMiner – filter editor window example settings. 

12. To close the Filter Editor window and save the changes, click the Ok button. 

13. From the Tools menu item, verify that Apply Selected Filters is checked. 

14. From the File menu item, select Export then Generate Filtered Output. 

15. Using the Open file window, navigate to and open a saved log file.  Log files are kept in the 

directory listed in the AISMiner.ini file setting LogDir (§ 4.1.1.10).       

16. In the Save File window, change the file name to “AnalysisFilterTest1.log” and click the 

Save button. 
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17. To start the analysis filtering process, from the main interface click the Resume playback 

button.  A notification message displays following completion of the Generate Filtered 

Output process. 

18. Figure 69 below shows results of the custom filter process.  To save the results to file for 

analysis, follow the steps outlined in section 5.1.5.2.1 (Example – Extract as Viewed), using 

the “AnalysisFilterTest1.log” saved log file.  Note that final results are dependent on the log 

file used. 

 

Figure 69.  AISMiner – custom analysis results.  

19. Close AISMiner. 

20. Using Microsoft Excel, navigate to and open the “AnalysisFilterTest1.csv” file created 

during step number 18.  Note, depending on your version of Excel, you may need to change 

the open file selection to “All Files” to view files with a csv extension. 

21. Using the Excel sort function, perform a custom sort first by Receiver ID, then Vessel ID, 

and finally Range.  Note the Sort window shown in figure 70 below is from Excel 2007. 

 

Figure 70.  Excel – sort window.  

22. Click the OK button. 
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23. Using the Excel Subtotal function, change the At each change in dropdown box to Rcvr ID; 

change the Use function dropdown box to Average; and, in the Add subtotal to list, uncheck 

any checked box and check the Range checkbox. 

 

Figure 71.  Excel – subtotal window – average analysis.  

24. Click the OK button. 

25. Scroll to the bottom of the dataset and click the minus symbol in line with the receiver 

average (red outline – Figure 72).  

 

Figure 72.  Excel – subtotal results.  

26. Click all subsequent minus symbols in line with receiver average until your final view 

appears similar to figure 73 below. 

 

Figure 73.  Excel – receiver average analysis results.  

27. Create a new worksheet and copy the Average values to the new worksheet. 

28. Using the Excel Subtotal function, change the Use function dropdown box to Count; in the 

Add subtotal to list, uncheck the Range checkbox and check the #Pos rpts checkbox. 
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Figure 74.  Excel – subtotal window – count analysis.  

29. Click the OK button. 

30. Scroll to the bottom of the dataset and click the minus symbol in line with the receiver count 

and all subsequent minus symbols in line with receiver count until your final view appears 

similar to figure 75 below. 

 

Figure 75.  Excel – receiver count analysis results.  

31. Copy the Count values to the new worksheet created in step 27. 

 

Figure 76.  Excel – receiver average and count analysis results.  

32. Using the Excel Subtotal function, change the Use function dropdown box to Max; in the Add 

subtotal to list, uncheck the #Pos rpts checkbox and check the Range checkbox. 



USCG R&DC  AISMiner (v4.0) User Manual 

 

June 2010  106 

 

Figure 77.  Excel – subtotal window – max analysis.  

33. Click the OK button. 

34. Scroll to the bottom of the dataset and click the minus symbol in line with the receiver max 

and all subsequent minus symbols in line with receiver max until your final view appears 

similar to figure 78 below. 

 

Figure 78.  Excel – receiver max analysis results.  

35. Copy the Max values to the new worksheet created in step 27 so that your results appear as 

shown in figure 79 below. 

 

Figure 79.  Excel – receiver average, count, and max analysis results. 

Figure 79 above shows the Average and Maximum AIS broadcast reception distance for two 

receivers at the Fishers Island, NY site during a six hour period on 7 April, 2009. 
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9 AUTOMATED DATA PROCESSING 

Several commonly used application features for processing AIS data can be executed indirectly 

using a batch file.  This can be beneficial when performing log file data processing on a regularly 

scheduled basis.  The following sections describe the steps involved in creating batch files used for 

automated data processing.     

Following is a list of batch file commands recognized by AISMiner: 

• 0:  Zero character.  Instructs AISMiner to execute the Extract as Viewed application feature 

(§ 5.1.5.2). 

• 1:  Instructs AISMiner to execute the Generate Filtered Output application feature (§ 

5.1.5.1). 

• 2:  Instructs AISMiner to execute the Extract as Viewed application feature using the 

previous days log file. 

• 3:  Instructs AISMiner to execute the Filter Live Data application feature (5.1.2). 

• -i:  Instructs AISMiner that what follows this command is the data input file path. 

• -o:  Instructs AISMiner that what follows this command is the data output file path. 

• -m:  Instructs AISMiner that what follows this command is the mode of operation 

designation (i.e., 0, 1, 2, or 3). 

• -w:  Instructs AISMiner that what follows this command is the application’s support files 

working directory path. 

Important:  Using a batch file command, other than those described above, will cause AISMiner to 

automatically shutdown. 

Figure 80 below shows an example [batch file] line statement for each of the four automated modes 

of operation; and one using the working directory feature (described below).   

 

Figure 80.  Automated Data Processing – example [1] batch file. 
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9.1 Example [1]: Extract as Viewed 

Following is a breakdown of the example line statement used to call the Extract as Viewed 

application feature (red outline – Figure 80 above).   

• “C:\AISMiner\AISMiner.exe”:  Application path to the AISMiner executable file.  

• -i:  Instructs AISMiner that what follows this command is the data input file path. 

• “C:\AISMiner\20090407.log”:  Path and name of log file for input data processing. 

• -o:  Instructs AISMiner that what follows this command is the data output file path. 

• “C:\AISMiner\20090407_ExtractAsViewed_Test.csv”:  Path and name of data output file.  

Note that the output file extension must be ‘csv’ when using the Extract as Viewed feature. 

• -m:  Instructs AISMiner that what follows this command is the mode of operation 

designation. 

• 0:  Zero character.  Instructs AISMiner to execute the Extract as Viewed application feature. 

Enter the above line statement (red outline – Figure 80 above) in a text editor such as Notepad using 

file paths and names that match that of your computer.  Note that a space is required between each 

line statement section.  Save the file using the ‘bat’ file extension.  To run the batch file, double click 

on it.  This action starts the AISMiner application in system memory (a graphical user interface is 

not shown), and begins the input data file processing event.  Just as if you had run the Extract as 

Viewed feature using the application menu selection, only filtered data (based on settings in the Filter 

Editor window), and fields shown in the table view (based on settings in the View Editor window), 

are saved to the output file.  Note that for Filter Editor window (§ 5.3.1) settings to be applied, the 

Apply Selected Filters menu item (§ 5.3.2) needs to have been set (checked) during the last 

application session.   

9.2 Example [2]: Generate Filtered Output 

Following is a breakdown of the example line statement used to call the Generate Filtered Output 

application feature (blue outline – Figure 80 above).   

•  C:\AISMiner\AISMiner.exe”:  Application path to the AISMiner executable file.  

• -i:  Instructs AISMiner that what follows this command is the data input file path. 

• “C:\AISMiner\20090407.log”:  Path and name of log file for input data processing. 

• -o:  Instructs AISMiner that what follows this command is the data output file path. 

• “C:\AISMiner\20090407_FilteredOutput_Test.log”:  Path and name of data output file.   

• -m:  Instructs AISMiner that what follows this command is the mode of operation 

designation. 

• 1:  Instructs AISMiner to execute the Generate Filtered Output application feature. 
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Enter the above line statement (blue outline – Figure 80 above) in a text editor such as Notepad 

using file paths and names that match that of your computer.  Note that a space is required between 

each line statement section.  Save the file using the ‘bat’ file extension.  To run the batch file, double 

click on it.  This action starts the AISMiner application in system memory (a graphical user interface 

is not shown), and begins the input data file processing event.  Just as if you had run the Generate 

Filtered Output feature using the application menu selection, only filtered data (based on settings in 

the Filter Editor window) are saved to the output file.  Note that for Filter Editor window (§ 5.3.1) 

settings to be applied, the Apply Selected Filters menu item (§ 5.3.2) needs to have been set 

(checked) during the last application session.   

9.3 Example [3]: Extract as Viewed – Yesterdays Data 

Following is a breakdown of the example line statement used to call the Extract as Viewed – 

yesterdays data application feature (green outline – Figure 80 above).   

• “C:\AISMiner\AISMiner.exe”:  Application path to the AISMiner executable file.  

• -m:  Instructs AISMiner that what follows this command is the mode of operation 

designation. 

• 2:  Instructs AISMiner to execute the Extract as Viewed application feature using the 

previous days log file. 

Unlike the Extract as Viewed feature, the Extract as Viewed – yesterdays data feature input and 

output data files are not defined in the batch file line statement.  Instead, the application reads these 

values from settings in the AISMiner INI support file (§ 4.1).   

The setting Auto Source Directory defines the directory path for input data files.  Within this 

directory, AISMiner checks for a folder named Year and a sub-folder named Month.  If the Year 

folder is not found, it defaults to the Month folder.  Within the Month folder, AISMiner checks for 

the previous days log file using the naming convention four-digit-year/two-digit-month /two-digit-

day (e.g., 20100315.log).   

The setting Auto Output Directory defines the directory path for output data files.  The output files 

are named the same as the input log files, but with the ‘csv’ file extension (e.g., 20100315.csv).    

Enter the above line statement (green outline – Figure 80 above) in a text editor such as Notepad 

using file paths and names that match that of your computer.  Note that a space is required between 

each line statement section.  Save the file using the ‘bat’ file extension.  To run the batch file, double 

click on it.  This action starts the AISMiner application in system memory (a graphical user interface 

is not shown), and begins the input data file processing event.  Just as if you had run the Extract as 

Viewed feature using the application menu selection, only filtered data (based on settings in the Filter 

Editor window), and fields shown in the table view (based on settings in the View Editor window), 

are saved to the output file.  Note that for Filter Editor window (§ 5.3.1) settings to be applied, the 

Apply Selected Filters menu item (§ 5.3.2) needs to have been set (checked) during the last 

application session.  
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9.4 Example [4]: Filter Live Data 

Following is a breakdown of the example line statement used to call the Filter Live Data application 

feature (purple outline – Figure 80 above).   

• “C:\AISMiner\AISMiner.exe”:  Application path to the AISMiner executable file.  

• -m:  Instructs AISMiner that what follows this command is the mode of operation 

designation. 

• 3:  Instructs AISMiner to execute the Filter Live Data application feature. 

The Filter Live Data feature is used to establish a connection to and begin processing of a live AIS 

data stream.  The feature operates the same as the Filter Live Data menu item (§ 5.1.2).  To 

configure AISMiner to read live data, see section 4.1.  The AISMiner INI file setting LogDir defines 

the directory path for output data files.  The output files are named using the naming convention 

four-digit-year/two-digit-month /two-digit-day (e.g., 20100315.log).   

Enter the above line statement (purple outline – Figure 80 above) in a text editor such as Notepad 

using file paths and names that match that of your computer.  Note that a space is required between 

each line statement section.  Save the file using the ‘bat’ file extension.  To run the batch file, double 

click on it.  This action starts the AISMiner application in system memory (a graphical user interface 

is not shown), and begins the live AIS data stream processing event.  Just as if you had run the Filter 

Live Data feature using the application menu selection, only filtered data (based on settings in the 

Filter Editor window) are saved to the output file.  Note that for Filter Editor window (§ 5.3.1) 

settings to be applied, the Apply Selected Filters menu item (§ 5.3.2) needs to have been set 

(checked) during the last application session.   

9.5 Example [5]: Extract as Viewed – Working Directory 

Following is a breakdown of the example line statement used to call the working directory 

application feature (orange outline – Figure 80 above).   

• “C:\AISMiner\AISMiner.exe”:  Application path to the AISMiner executable file.  

• -i:  Instructs AISMiner that what follows this command is the data input file path. 

• “C:\AISMiner\20090407.log”:  Path and name of log file for input data processing. 

• -o:  Instructs AISMiner that what follows this command is the data output file path. 

• “C:\AISMiner\20090407_ExtractAsViewed_WD_Test_1.csv”:  Path and name of data output 

file.  Note that the output file extension must be ‘csv’ when using the Extract as Viewed 

feature. 

• -m:  Instructs AISMiner that what follows this command is the mode of operation 

designation. 

• 0:  Zero character.  Instructs AISMiner to execute the Extract as Viewed application feature. 
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• -w:  Instructs AISMiner that what follows this command is the application’s support files 

working directory path. 

• “C:\AISMiner\Support_Files_1”:  Directory path containing the application support files to 

use during execution of the designated mode of operation.  

A powerful tool of Automated Data Processing is the working directory feature.  This feature allows 

a user to direct AISMiner to use specific application support files when executing a mode of 

operation from a batch file line statement.  Using this feature, a user can execute the same mode of 

operation more than once on the same data input file, with each execution call using different 

support files; each with settings configured to meet specific requirements for the data output file.  As 

shown in figure 81 below, this feature capability can be mixed and matched between support files 

and modes of operation.  Note that this feature only works with saved log files (operation modes 0-

2).   

 

Figure 81.  Automated Data Processing – example [2] batch file. 

The following example demonstrates the Automated Data Processing working directory feature: 

1. Under the “C:\AISMiner\” application directory create two folders; named 

“Support_Files_1” and “Support_Files_2.” 

2. Start AISMiner. 

3. Using the Filter Editors window (§ 5.3.1), edit the Bounded Region section to filter for data 

from the U.S Northeast region. 

4. Click the Ok button to close the window and save the changes to the Filters.ini support file.  

5. Navigate to the application directory and copy the support files AISMiner.ini; BaseInfo.txt; 

VesselList.txt; and, Filters.ini (which contains the custom Northeast region filter settings 

from step 3 above), to the “Support_Files_1” folder. 

6. Using the Filter Editors window, edit the Bounded Region section to filter for data from the 

U.S Southwest region. 

7. Click the Ok button to close the window and save the changes to the Filters.ini support file.  

8. Navigate to the application directory and copy the support files AISMiner.ini; BaseInfo.txt; 

VesselList.txt; and, Filters.ini (which contains the custom Southwest region filter settings 

from step 6 above), to the “Support_Files_2” folder. 

9. From the Tools menu item verify that Apply Selected Filters is checked.   
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10. To close AISMiner, from the File menu item, select Exit. 

11. Using Notepad, enter the following two line statements using file paths and names that match 

that of your computer.  Note that a space is required between each line statement section. 

• “C:\AISMiner\AISMiner.exe -i C:\AISMiner\20090407.log -o 

C:\AISMiner\20090407_ExtractAsViewed_WD_Test_1.csv -m 0 -w 

C:\AISMiner\Support_Files_1.”  

• “C:\AISMiner\AISMiner.exe -i C:\AISMiner\20090407.log -o 

C:\AISMiner\20090407_ExtractAsViewed_WD_Test_2.csv -m 0 -w 

C:\AISMiner\Support_Files_2.”  

12. Save the file using the ‘bat’ file extension.   

13. To run the batch file, double click on it. This action starts the AISMiner application in system 

memory (a graphical user interface is not shown), and begins the input data file processing 

event.  The processing event will execute twice; once for each line statements entered in step 

11 above.  

14. Navigate to the “C:\AISMiner\” application directory. 

15. Using Excel, open the two data output files; “20090407_ExtractAsViewed_WD_Test_1.csv” 

and “20090407_ExtractAsViewed_WD_Test_2.csv.”   Note that the records in each file 

correspond to region filters set in step 3 and 6 above.   

By setting a batch file to run each day at a regularly scheduled time, using log files automatically 

generated by AISMiner from a live AIS data stream, the time spent by a user executing application 

features manually can be greatly reduced.  This can be of great benefit to those responsible for 

development of daily performance analysis data used to populate the NAIS Analysis website.  
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APPENDIX A. LIST OF TERMS AND ABBREVIATIONS 

AIS 

Automatic Identification System:  The Automatic Identification System is 

a system used by ships and Vessel Traffic Services (VTS) principally for 

identification and locating vessels. AIS provides a means for ships to 

electronically exchange ship data including: identification, position, course, 

and speed, with other nearby ships and VTS stations. This information can be 

displayed on a screen or an ECDIS display. AIS is intended to assist the 

vessel's watchstanding officers and allow maritime authorities to track and 

monitor vessel movements. 

AISSource 

AISSource is a software application designed to manage AIS data.  It serves 

as a means of communication between AIS data input devices and AIS 

servers.  Data from AIS sensors (e.g., AIS base station, VHF antenna) are 

received, processed, and distributed to AIS servers.  The distribution process 

is controlled through settings defined in the applications initialization file.   

AISUser 

AISUser is a software application designed to manage the distribution of AIS 

data.  The application receives AIS data from an AIS server and distributes 

the data to end user applications.  User defined settings in the application 

initialization file control the distribution process.   

AIVDM 
AIVDM:  [AI] NMEA mobile identifier for class A and B AIS station. 

[VDM] Very High Frequency (VHF) Data Link Message.   

AtoN 

Aids to Navigation:  Marker or device that provides a vessel operator with 

location information.  This can encompass lighthouses, buoys, various 

markers, daybeacons, and fog signals. 

Chayka 
Chayka:  Russian terrestrial radio navigation system, similar to LORAN-C. 

It is also run on 100 kHz and is described like LORAN-C by its GRI. 

COG 
Course Over Ground:  The current direction (in degrees) that a vessel is 

actually traveling. 

COMMS Abbreviation for Communications. 

Contact 
AIS equipped vessel whose transmission (broadcast) has been received by an 

AIS receiver. 

CSTDMA 
Carrier Sense Time Division Multiple Access:  See International 

Telecommunications Union (ITU) Standard 1371. 

dBm 
dBm:  The power ratio in decibels (dB) of the measured power referenced to 

one milliwatt (mW) 

degs Abbreviation for Degrees. 

DGNSS 

Differential Global Navigation Satellite Systems:  [GNSS] Standard 

generic term for satellite navigation systems that provide autonomous geo-

spatial positioning with global coverage. 

ETA 
Estimated Time of Arrival: Measure of when a ship is expected to arrive at 

a specified location. 

FM 
Frequency Modulation: In telecommunications, FM conveys information 

over a carrier wave by varying its frequency. 

GLONASS 
Global Navigation Sputnik System:  A radio-based satellite navigation 

system developed by the former Soviet Union and now operated for the 
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Russian government by the Russian Space Forces.  

GMSK 

Gaussian Minimum Shift Keying:  A continuous-phase frequency-shift 

keying modulation scheme. It is similar to standard minimum-shift keying 

(MSK); however the digital data stream is first shaped with a Gaussian filter 

before being applied to a frequency modulator. 

GMT 
Greenwich Mean Time:  Mean solar time at the Royal Observatory in 

Greenwich, London. 

GPS 

Global Positioning System:  A satellite-based navigation system made up of 

a network of 24 satellites placed into orbit by the U.S. Department of 

Defense. 

ID Abbreviation for Identification. 

IEC 

International Electrotechnical Commission:  A not-for-profit, non-

governmental international standards organization that prepares and 

publishes International Standards for all electrical, electronic, and related 

technologies.  Marine equipment required under the “Safety Of Life At Sea” 

Treaty must comply with IEC test standards. 

IMO 

International Maritime Organization:  Formerly known as the Inter-

Governmental Maritime Consultative Organization (IMCO), it was 

established in 1948 through the United Nations to coordinate international 

maritime safety and related practices.  Changes to its SOLAS Treaty 

essentially impact all commercial vessels that conduct international voyages. 

INI Abbreviation for Initialization.  

IP 

Internet Protocol:  A protocol used for communicating data across a packet-

switched internetwork using the Internet Protocol Suite, also referred to as 

TCP/IP. 

IPv4 

Internet Protocol Version 4:  A connection-less protocol to be used on 

packet-switched Link Layer networks (e.g., Ethernet).  It operates on a best 

effort delivery model, in that it does not guarantee delivery, nor does it 

assure proper sequencing, or avoid duplicate delivery.  These aspects, 

including data integrity, are addressed by an upper layer transport protocol 

(e.g., Transmission Control Protocol).  IPv4 provides only header integrity 

achieved with a checksum. 

ITDMA Incremental Time Division Multiple Access:  See ITU standard 1371. 

ITU-R 

International Telecommunications Union – Radiocommunications:  One 

of the three sectors (divisions or units) of the International 

Telecommunication Union (ITU) and is responsible for radio 

communication.  Its role is to manage the international radio-frequency 

spectrum and satellite orbit resources and to develop standards for 

radiocommunications systems with the objective of ensuring the effective 

use of the spectrum.  

kHz Kilo Hertz: Unit of frequency. 

kt 
Knot:  A unit of speed equal to one nautical mile per hour, which is equal to 

exactly 1.852 km/h and approximately 1.151 mph. 

LAN 

Local Area Network:  A computer network covering a small physical area, 

like a home, office, or small group of buildings, such as a school, or an 

airport.  The defining characteristics of LANs, in contrast to wide-area 

networks (WANs), include their usually higher data-transfer rates, smaller 

http://en.wikipedia.org/wiki/International_Telecommunication_Union
http://en.wikipedia.org/wiki/International_Telecommunication_Union
http://en.wikipedia.org/wiki/Radio
http://en.wikipedia.org/wiki/Radio-frequency_spectrum
http://en.wikipedia.org/wiki/Radio-frequency_spectrum
http://en.wikipedia.org/wiki/Satellite_orbit
http://en.wikipedia.org/w/index.php?title=Radiocommunications&action=edit&redlink=1
http://en.wikipedia.org/wiki/Spectrum
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geographic area, and lack of a need for leased telecommunication lines. 

lat 

Latitude:  An angular measurement in degrees (marked with °) ranging from 

0° at the equator (low latitude) to 90° at the poles (90° N or +90° for the 

North Pole and 90° S or −90° for the South Pole). 

lon 

Longitude:  The east-west angle, referenced to the center of the Earth as 

vertex, between the intersections with the equator of the meridian through the 

location in question and the prime meridian.   
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Loran-C 

LOng RAnge Navigation:  Terrestrial radio navigation system using low 

frequency radio transmitters that uses multiple transmitters (multilateration) 

to determine the location and speed of the receiver. The current version of 

LORAN in common use is LORAN-C, which operates in the low frequency 

portion of the EM spectrum from 90 to 110 kHz. 

MMSI 

Maritime Mobile Service Identification: MMSI numbers are unique 

identification numbers issued to all commercial vessels which are subject to 

Safety of Life at Sea (SOLAS) regulations.  MMSI numbers are issued by 

International Telecommunications Union (ITU).  MMSI numbers are used by 

AISMiner to uniquely identify a contact (vessel).    

NAIS 

Nationwide Automatic Identification System:  USCG project to develop, 

install and support a nationwide system to detect, identify, track and 

exchange information with Automatic Identification System (AIS)-equipped 

vessels operating in or approaching U.S. waters for Maritime Domain 

Awareness (MDA) and enhanced U.S. Coast Guard (USCG) and DHS 

operational mission performance.  Implemented over three increments: The 

first establishes an AIS-receive only capability in the nation’s most critical 

ports and coastal areas; the second provides full receive and transmit 

capability for the entire U.S. coastline nationwide and the third extends the 

nationwide receive coverage out to 2000 nautical miles (NM). 

Nav Abbreviation for Navigation. 

NMEA 

National Marine Electronics Association:  A not-for-profit, non-

governmental organization that prepares and publishes electrical and data 

standards for the data interface of marine electronic devices such as AIS 

transceivers, GPS receivers, sonar, anemometers, gyrocompass, autopilot, 

and many other types of instruments.  NMEA standards have been adopted 

by the IEC for use with marine equipment required under the SOLAS Treaty. 

POS Abbreviation for Position. 

PRDC 

Proprietary Research and Development Center:  [P] Proprietary identifier 

of NMEA 0183 sentence.  [RDC] NMEA registered identifier of USCG 

R&D Center.  [PRDC] Designation used to identify proprietary messages to 

meet requirements of the R&D Center. 

RAIM 

Receiver Autonomous Integrity Monitoring: A technology developed to 

assess the integrity of Global Positioning System (GPS) signals in a GPS 

receiver system. 

RCVR Abbreviation for (AIS) Receiver.   

RDC 
Research and Development Center:  Organizational unit of the USCG 

under the office of Acquisition. 

ROT 

Rate Of Turn: A measurement of how fast a contact is changing course.  In 

AISMiner, ROT is reported as the number of degrees per minute (between 0 

and 720). 

RSSI 
Received Signal Strength Indicator:  A measurement of the power present 

in a received radio signal.   

SAR 
Search And Rescue:  USCG mission; to search for and recover survivors of 

sea vessels in distress. 

secs Abbreviation for Seconds.   
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SIM Abbreviation for Simulation. 

SOG Speed Over Ground: The speed of a vessel relative to the ground.  

SOLAS 

Safety of Life at Sea:  A global treaty protecting the safety of commercial 

ships, their crew, and passengers.  It prescribed numbers of lifeboats and 

other emergency equipment along with safety procedures. 

SOTDMA 

Self-Organizing Time Division Multiple Access:  The term Self-organizing 

describes that VHF Data Link (VDL) Mode 4 uses a protocol, VDL Mode 4 

Interface Protocol (VIP), that does not require a ground infrastructure 

because of the synchronization to UTC.  Time Division Multiple Access 

(TDMA) divides the VHF channel into frames, which furthermore is 

subdivided into a vast number of time slots.  TDMA gives the opportunity 

for every station to use the whole bandwidth for the, with respect to time, 

non-overlapping signals.  A challenge with this method is to take care of the 

time synchronization.  In VDL Mode 4 the time slots are synchronized to 

UTC and every slot is an opportunity for a station to transmit. 

TAG 
Transport, Annotate, and Group [Block]:  See NMEA 0183 v4.0 section 

7. 

TDMA 

Time Division Multiple Access:  A channel access method for shared 

medium networks.  It allows several users to share the same frequency 

channel by dividing the signal into different time slots. 

TOA 
Time of Arrival:  A precise measurement of the time when a radio signal is 

detected.  A common time reference is Universal Time. 

TransView 
U.S. Government developed and owned application used to display AIS track 

data. 

URL 

Uniform Resource Locator:  A subset of the Uniform Resource Identifier 

(URI) that specifies where an identified resource is available and the 

mechanism for retrieving it. 

USCG 
United States Coast Guard:  Law enforcement and maritime safety agency 

of the U.S. Government under the Department of Homeland Security. 

UTC 

Coordinated Universal Time (UTC):  A time standard based on 

International Atomic Time (TAI) with leap seconds added at irregular 

intervals to compensate for the earth's slowing rotation 

VDM VHF Data Link Message:  See NMEA 0183 v4.0 section 9.2. 

VDO VHF Data Link Own Vessel Report: See NMEA 0183 v4.0 section 9.2. 

VHF 

Very High Frequency:  The radio frequency range from 30 MHz to 300 

MHz. Frequencies immediately below VHF are denoted High Frequency HF, 

and the next higher frequencies are known as Ultra high frequency (UHF).  

Common uses for VHF are FM radio broadcast, television broadcast 

(together with UHF), Amateur Radio, marine communications, air traffic 

control communications and terrestrial navigation systems (VOR in 

particular). 

VTS 

Vessel Traffic Services:  In the U.S., a marine traffic monitoring and 

waterways management system operated by the USCG.  Typical VTS 

systems use radar, closed-circuit television, VHF radio, and AIS to track 

vessel movements and provide navigational safety in a limited geographical 

area. 
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